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About KID PIX 5
The new S.T.E.A.M. edition of KID PIX enters a world where art and science reunite and critical 
thinking meets creative making. Your young artists can now transform their stories and adventures 
into interactive digital art, science and math projects with the help of KID PIX features tailored to 
suit the needs of ingenious young innovators everywhere.

KID PIX lets you create pictures using a vast array of art tools, and then put these pictures into a 
Slide Show with visual transitions and sounds.

KID PIX 5 supports all files created with Kid Pix 4, Kid Pix Deluxe 3X, and KID PIX 3D.

In this chapter you will learn about: 

• KID PIX 5 System Requirements 

• What’s New in KID PIX 5

• Getting Started 

• The KID PIX Paint Zone

• The KID PIX Slide Show

• Using the Menus 

• Getting Help

• Removing KID PIX 5 

KID PIX 5 System Requirements 

Minimum system requirements: 

• OS X® 10.10.5 or later, including macOS 10.14 Mojave

• 1024 x 768 display resolution, millions of colors

• 4.2 GB of free space

• Built-in or external video camera — for recording videos and taking photos

• Microphone — for the Sound Art Tool and recording narrations and other sounds

• Internet connection — for publishing to YouTube™
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What’s New in KID PIX 5

New interface design

KID PIX 5 comes in a splendiferous new Steam Age interface, with cogs, rivets, gleaming brass, and 
even an amazing mechanical cleaning contraption. At the same time, it has been remade so carefully 
that all kids, newcomers and “old hands” alike, will feel instantly at home.

Interactivity

Make your own interactive “clickables” — characters and objects that start to play and move only 
when you click them. For more information, see “Interactive Objects” on page 43.

Individual object sounds

Now you can attach sounds directly to objects to get clocks that tick, dragons that talk, or flowers 
that make music as they grow. See “Attaching Sounds to Objects” on page 52.

Button stickers

New button stickers let you add interactive navigation options in Slide Shows. For more information, 
see “Using the Button Stickers” on page 38.

Export to HTML5

Welcome to an elegantly simple way to share what you create with KID PIX! Utilizing the power of 
HTML5 technology, KID PIX lets you export your pictures and Slide Shows as web pages in just a 
couple of clicks. The exported projects can be opened in almost any modern web browser and retain 
all their movement, sound, and interactivity. For more information, see “Exporting Your Project” on 
page 60 and “Exporting Your Slide Show” on page 69.

Auto-perspective effect

Bring a sense of perspective to your path animations with this new feature. Objects gradually grow 
larger as they move towards the bottom of the canvas, as if they’re getting closer, and smaller as 
they travel towards the top, like they’re moving away. For more information, see “Using the Auto-
Perspective Effect” on page 41.

Easier for small kids

• More features, such as sticker creation, available as buttons instead of menus.
• Simplified Color Picker provides a selection of 12 essential colors.
• Easy, intuitive workflow for recording sound and video.

Enhanced video narration

Videos and costume frames now move together when animated — so kids can not only appear in 
their own stories, they can be part of the action as well.

Create your own video backgrounds

Turn any video — even your own imported movie — into a “living backdrop” for your picture. For 
more information, see “Video Backgrounds” on page 35.
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Multilayer 3D backgrounds

New multilayered 3D backgrounds provide hiding places for your characters, add perspective to your 
projects, and can be combined with video backgrounds to transport your whole 3D movie set to 
exotic locations. See “Combining Backgrounds” on page 35.

Rotating objects

Just press the Command key and drag to get your story’s characters turning somersaults. For more 
information, see “Path Animation Tool” on page 40.

Growing objects

Hold down the Shift key while you drag to get an object that grows as it goes — giving the effect of 
it moving towards you in the picture. For more information, see “Path Animation Tool” on page 40.

Triple soundtracks

Add up to three soundtracks to make stories with narration, music, and sound effects. For more 
information, see “Multiple soundtrack” on page 45.

Voiceovers for Slide Shows

Record a full narration for your entire Slide Show, or give voices to the characters in your animated 
story. For more information, see “Adding a Voiceover to Your Slide Show” on page 67.

Enhanced cut-out stickers

Create a sticker from part of the background using the Scissors tool and make any white areas 
transparent — or leave them as they are if it suits your project better. For more information, see 
“Scissors Tool” on page 32.

Photo stickers

Create stickers from photos taken with your computer’s camera — all from within KID PIX. For more 
information, see “To take an instant picture:” on page 50.

Flipbook and Storybook options for Slide Shows

Creating your own animations and multi-project stories is now even easier with two new transition 
presets for Slide Shows: Flipbook changes slides quickly to make frame-by-frame animations, while 
Storybook ensures everything on a slide is played before the show advances. For more information, 
see “Setting Up Transition Options” on page 64.

50% more transition effects for Slide Shows

With 50 transition effects, including 18 brand new ones like Confetti and Mosaic, KID PIX 5 has more 
ways than ever before for you to make your Slide Show something special.

Import of users lists

Now there’s a quick and easy way to add multiple users rather than typing them in one by one. 
Just create a text file with a list of users’ names and import it in a snap. For more information, see 
“Setting Up Multiple Users” on page 77.
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Getting Started 

To install KID PIX: 

1 .  Put the KID PIX DVD in the DVD-ROM drive or double-click the disc image file that you have 
downloaded. The KID PIX window appears. 

2 .  Double-click the KID PIX Installer icon and follow the onscreen instructions.
3 .  When asked, select either Home or School installation depending on where you are going to 

use KID PIX and click Continue.
4 .  Select the In-app multiple user login option if KID PIX users do not have their own 

separate macOS user accounts on this computer. KID PIX files will then be stored under their 
KID PIX user names in the KID PIX Users folder inside the system user’s Documents folder.
Select the Display update notifications option if you want users to be notified when new 
versions of KID PIX are available. Click Continue.

5 .  Click Change if you want change the location to install KID PIX. Otherwise, click Next.
6 .  Click Install and wait while KID PIX is installed.
7 .  Click the Close button.

Tip: To be able to launch KID PIX from the Dock, drag the KID PIX icon to the Dock from 
the Applications folder after installation.
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To launch KID PIX: 

Open the Applications folder, and then double-click the KID PIX icon, or click the KID PIX icon in 
the Dock if it is there.

To register KID PIX: 

Register your copy of KID PIX to be notified about product updates and news. You can register by 
choosing the KID PIX Registration command from the KID PIX application menu. For information 
on displaying the menu bar, see “Using the Menus” on page 12.

To log in to KID PIX: 

If you selected the In-app multiple user login option during installation, the Login dialog appears 
when you launch KID PIX. If the Login dialog does not appear and you would like it to, open the KID 
PIX Preferences dialog, select the Multiple user login checkbox, and then relaunch the application. 
For more information, see “Turning the Login Dialog On and Off” on page 78.

1 .  Type your name in the box labeled “Name” and click the Add User button (+).

2 .  Click Go to open KID PIX 5. 

From now on, your name will be in the “User List” box, and you can double-click it to start using KID 
PIX. For details on adding more users, see “Setting Up Multiple Users” on page 77. 
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The KID PIX Paint Zone
After launching KID PIX 5, you arrive in the Paint Zone. For more information on using the Paint 
Zone, continue reading this user guide.

Library 
Tools

Undo Guy

Basic 
Colors

Play 
Project

Drawing 
Area

Trash 
Can

Slide 
Show 
Tube

Color Swatch Libraries Options Tray

Add 
Project 
to Slide 
Show

Art Tools

Go to 
Slide 
Show

Help ModeNewSave Project’s TitleProject 
Templates

Gallery
Quit

Change User Print
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The KID PIX Slide Show
You can make a Slide Show with your pictures. For more information on Slide Shows, see “Working 
with Slide Shows” on page 62.

Transition 
Options

Slide 
Thumbnail

Play Slide 
Show

Help ModePrintNew Slide Show

Trash Can

Loop Switch

Voiceover

Background 
Color

Save

Slide Show 
Style

Undo Guy

Show’s TitleGallery Change User

Go to Paint 
Zone

Background 
Sound

Using the Menus
KID PIX has menus you can display and use. For a full list of all the menu commands, see “The KID 
PIX Menus” on page 79.

To display and use the menus:

1 .  Position the pointer at the very top of the screen by moving your mouse. The menu bar will 
appear.

Note: This is also the way to display the Dock so you can switch to another application. To 
see it, just move the pointer to the edge of the screen where it is located.

2 .  Click a menu title to open the menu, and then click the command you want to choose.

Getting Help
When you use KID PIX, you can easily find information about items on the screen. There are 
different types of help available: Help Mode, Coaching Help, Help Tags, and the User Guide.

Quit
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Help Mode
1 .  Click the Help Mode button or choose Turn Help Mode On from the Help menu. 

2 .  KID PIX starts highlighting main areas on the screen while displaying the 
corresponding help message and reading it aloud. Read and listen to the help message.

3 .  To go one step back or forward or to pause the display of help messages, use the 
playback control buttons below the messages. You can also click an area of the screen 
that you want to get help with.

4 .  Click the Help Mode button again or choose Turn Help Mode Off from the Help 
menu to leave Help Mode.

Coaching Help
You can get hints on using the currently selected tool if there has been no mouse or keyboard 
activity for a certain period of time. A voice reads the helpful tips out loud while highlighting appears 
on the screen, showing you what to click. You can turn Coaching Help on or off, set the period of 
time after which it starts, and choose the voice that reads the hints. For details, see “Setting Up KID 
PIX Preferences” on page 73.

Help Tags
If you want to know what a tool or button does, hold the pointer over it for a few seconds. A short 
explanation will appear. You can also have your computer read the help tags out loud for you. These 
features can be set up on the Help pane of KID PIX preferences.

Tip: To quickly turn help tags on or off, use the Turn Help Tags On/Off command in the Help 
menu.

KID PIX User Guide
1 .  From the Help menu, choose KID PIX User Guide.

2 .  Read or print the information.

Removing KID PIX 5

To remove KID PIX 5 from your computer:

1 .  Drag the KID PIX application to the Trash. (The application is located in the main 
Applications folder on the system disk.)

2 .  For Home installation, drag the KID PIX Users folder to the Trash. (The folder is located 
inside each user’s Documents folder.) For School installation, open each user’s Documents 
folder, and then drag KID PIX documents and the KID PIX Libraries folder to the Trash.

3 .  Open the Go menu in the Finder, hold down the Option key, and then choose the Library item 
that appears. This will open your Library folder.

4 .  In your Library folder, open the Preferences folder, find the com.mackiev.KidPixMac.plist file, 
and drag this file to the Trash.

5 .  Go back to your Library folder, open the Application Support folder and then the Software 
MacKiev folder, find the KID PIX folder, and drag it to the Trash.

6 .  If you have placed the KID PIX icon in the Dock, drag it out.

7 .  Empty the Trash.
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Using the Art Tools
In this chapter you will learn about:

• Using Drawing Tools

• Using Painting Tools

• Using Paper Textures

• Using Paint Bucket Tools

• Using Mixer Tools

• Using Rubber Stamp Tools

• Editing Rubber Stamps

• Using Color Swatch and Eye Dropper

• Using Eraser Tools

• Using Multi-Level Undo Guy

Using Drawing Tools
Use KID PIX Drawing Tools to draw different kinds of lines and shapes. There are four drawing 
tools: Pencil, Chalk, Crayon, and Marker. You can draw freestyle, straight or curved lines, 
rectangles, circles, or polygons.

To draw:
1 .  Click the Drawing Tools button.

Shape 
Outline

Circle 
Outline

Box 
Outline

Freestyle 
Line

Straight 
Line

Marker 
(see-through)

Chalk 
(soft/fuzzy)

Pencil 
(solid)

Crayon 
(hard/fuzzy)

Line Thickness Curved 
Line

Filled 
Box

Filled 
Circle

Filled 
Shape

2 .  Pick a tool.

3 .  Select a thickness for the line.

4 .  Select a shape or a line type.

5 .  Click in the drawing area and, holding down the mouse button, move the mouse around to 
draw.
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For rectangles, circles, and polygons, you can draw either a filled or an outline shape. Outlines let 
the background show through.

• To draw a curve, click the Curved line and click in the drawing area in the place where you 
want to start drawing a curve. Holding down the mouse button, draw a straight line. Release 
the mouse button, and then press and hold it again and move the pointer to bend the line to a 
curve. Release the mouse button when you have the curve you want.

• To draw a polygon, click the Shape outline or Filled shape. Draw the sides, clicking at the 
end of each one. Finish by clicking the starting point again.

Drawing Tips
• If you change the paper texture and then draw with the Crayon, Chalk, or Marker, the 

texture shows through under your drawing. For more information on using paper texture, see 
“Using Paper Textures” on page 17.

• To draw perfectly vertical, horizontal, and diagonal (45-degree) lines with the Straight Line tool, 
or perfect squares and circles with the Box and Circle tools, hold down the Shift key while 
drawing.

Using Painting Tools
Use KID PIX Painting Tools for a dazzling array of realistic and out-of-this-world painting effects. 
There are three different tools: Paint Brush, Sound Art tool, and Spray Can. Each tool has two 
modes.

To paint:

1 .  Click the Painting Tools button.
2 .  Click Paint Brush, Sound Art, or Spray Can. See the next few pages for more information 

about each kind of tool.
Paint StylesPaint Modes

Paint Brush More Paint Style OptionsPaint Brush Size

More Paint Style Options

3 .  Select a size (not every tool has a size selection).
4 .  Select a painting mode. When you pick a mode, the options change.
5 .  Drag the slider at the bottom of the tray or click the handle at the top of the tray to see more 

painting options.
6 .  Select a painting option.
7 .  Click the drawing area and, holding down the mouse button, move the mouse around to 

paint.

Paint Brush
Click Paint Brush and select a brush size and painting mode. In the Realistic Paint mode you can 
paint like with a real brush.
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The Wacky Paint mode creates magical effects.

Wacky Paint Mode

Note: Most of the Wacky Paint options change their drawing style when you press the Shift, 
Option, or Command keys while drawing.

The Sound Art Tool
To use the Sound Art tool, you need to talk, sing, or play music into your Mac’s built-in microphone 
or one attached to your computer. 

The Mouse-Move mode lets you direct the painting with your mouse and voice.
Sound Art Tool Mouse-Move Mode

The Hands-Free mode lets the sound do the painting.

Hands-Free Mode

Note: If this tool does not work properly, make sure you have your microphone connected and that 
the corresponding device is selected in the Input pane in the Sound pane of System Preferences.

Spray Can
The Paint Shapes mode sprays three-dimensional shapes: balloons, bugs, candies, and much more. 

Paint Shapes Mode

Spray Can
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The Moving Paints mode sprays balloons, bubbles, and creatures that dance, fly, hop, or wiggle.

Moving Paints Mode

Painting Tips
• Experiment with Painting Tools, modes, and options. Try lots of different combinations.

• For information on adding text in the Wacky Paint mode of the Paint Brush tool, see “Alphabet 
Text Tool” on page 25.

• Some of the Realistic Paint options of the Paint Brush tool let the paper texture show 
through.  
For more about paper texture, see “Using Paper Textures” below.

Using Paper Textures
You can change the background texture of your KID PIX picture. Then, when you draw with the 
Crayon, Marker, Chalk, or use some of the Realistic Paint options of the Paint Brush tool, a 
pattern will show through under your drawing.

To change a paper texture:

1 .  Select the Crayon, Marker, or Chalk, or the Realistic Paint mode of the Paint Brush tool.

2 .  Click the Paper Texture Case at the left of the drawing or painting options. A selection of 
textures appears.

3 .  Drag the slider at the bottom of the tray or click the handle at the top of the tray to see more 
paper textures.

4 .  Click the texture you want.

5 .  Draw or paint with the selected tool or any of the other tools that show paper textures. You 
will see the texture in your picture. 
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Using Paint Bucket Tools
Paint Buckets let you fill up an area of your picture. There are three kinds of Paint Bucket Tools. 
Single Color Paint Bucket fills an area with one solid color or a single-color pattern. Blend of Colors 
Paint Bucket fills an area with a blend of colors. Multicolor Pattern Paint Bucket fills an area with a 
multicolor pattern.

To fill an area:

1 .  Click the Paint Bucket Tools button to see the Paint Buckets tray. 

2 .  Pick a bucket in the left side of the tray.

3 .  Select a fill option from the right side of the tray. You can drag the slider at the bottom of the 
tray or click the handle at the top of the tray to see more fill options.

4 .  Click inside the area you want to fill in your picture.

The Single Color Paint Bucket uses the current color in the Color Swatch. Select solid color or one 
of the single-color patterns.

Selected Solid Color Fill

Single Color Paint Bucket

More Fill Options

Single Color Pattern Option

The Blend of Colors Paint Bucket does not use the current color in the Color Swatch. You can pick 
any of the blends to use in your painting. 

Blend of Colors Paint Bucket

The Multicolor Pattern Paint Bucket does not use the current color in the Color Swatch. You can 
pick any of the multicolored patterns to use in your painting.

Multicolor Pattern Paint Bucket
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Fill Tips
• Position the pointer on your picture and click and hold the mouse button down while the blend 

or pattern effects appear. Then, without releasing the mouse button, you can move the mouse 
around to change how the blend colors or pattern appear inside the area in your picture.

• You can design your own two-color patterns. Fill an area with a solid color, then change the 
color in the Color Swatch and fill the same area with a single-color pattern.

• For information on changing the color for the Single Color Paint Bucket, see “Using Color 
Swatch and Eye Dropper” on page 21

Using Mixer Tools
Mixers mix up your picture. You can mix up the whole painting with the Mega Mixer, or just parts of 
the picture with the Mixer Wand.

To mix things up:

1 .  Click the Mixer Tools button to see the Mixers tray.

Mega Mixer

Mixer Wand

 Mixer Effect Size Mixer Effect Preview

More Mixer Effects

2 .  Pick the Mega Mixer or the Mixer Wand in the left side of the tray. The Mega Mixer mixes 
up the whole picture with one click; the Mixer Wand mixes the places where you drag it.

3 .  Select a mixer effect from the right side of the tray. You can drag the slider at the bottom of 
the tray or click the handle at the top of the tray to see more mixer effects.

4 .  Select a mixer effect size.
5 .  Click your picture with the Mega Mixer or drag the Mixer Wand to mix areas in your picture.

Mixer Tips
• Mix up an imported photograph for fun results. For information on importing photos, see 

“Adding Pictures” on page 50.

• The size of the Mega Mixer and Mixer Wand influences the intensity of the mixer effect.
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Using Rubber Stamp Tools
Use the Rubber Stamp Tools to stamp different images onto your picture.

To use Rubber Stamp Tools:

1 .  Click the Rubber Stamp Tools button to see the Rubber Stamps tray.
Stamp Editor

Categories Size Rubber Stamp Preview

2 .  Choose a category from the Categories list.

3 .  Select a size for your rubber stamp.

4 .  Select a rubber stamp, then click your picture.

Editing Rubber Stamps
You can edit rubber stamps.

To edit rubber stamps:

1 .  Click the Rubber Stamp Tools button to see the Rubber Stamps tray.

2 .  Click the stamp you want to edit.

3 .  Click the Stamp Editor button to open the Stamp Editor.

Note: Alternatively, you can open the Stamp Editor by double-clicking the stamp you want 
to edit in the Rubber Stamps tray.

Pencil

Fill Bucket

Rotate and  
Flip Horizontally

Add Stamp and 
Restore Original

Undo Guy

Mini Eraser

Trash Can

OK

Stamp Preview

Cancel

Color Picker
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Use these tools to change your stamp:

• Use Pencil to draw on the stamp.

• Pick a color in the Color Picker and use Fill Bucket to recolor the stamp.

• Use Mini Eraser to remove small portions of the stamp.

• Click the Rotate button to turn the stamp 90 degrees clockwise. You can do this several 
times.

• Click the Flip Horizontally button to turn your stamp over from left to right, giving you a 
mirror image.

• Click the Undo Guy button to undo your action, or click the Restore Original button to 
go back to the original view of the stamp.

• Click the Add Stamp button at any time to add the current view of the stamp to the My 
Stamps category.

• Click the Trash Can to erase the whole stamp so you can start your own stamp from 
scratch.

4. Click the OK button when you are finished. The edited stamp will be added to the My Stamps 
category for you to use whenever you wish.

Using Color Swatch and Eye Dropper
Many KID PIX art tools use the color you choose from the Color Picker. You can see the current 
color in the Color Swatch at the bottom-left corner of the working area and on many art tools. Above 
the Color Swatch there are six default colors which you can click to pick: red, yellow, green, blue, 
white, and black.

The Color Picker also includes Eye Dropper, a tool that lets you pick up and use any color in your 
picture.

To pick a color in the Color Picker:

1 .  Click the Color Swatch. The Color Picker pops up.

Eye Dropper

Color Picker

2 .  Click a color in the Color Picker. As soon as you pick a color, the Color Swatch changes 
to show your new choice, and the Color Picker closes. You can continue working with  
KID PIX.

Color Swatch
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To pick up a color with the Eye Dropper:

1 .  Open the Color Picker by clicking the Color Swatch.
2 .  Click the Eye Dropper.
3 .  Move the crosshair pointer over the screen. As the pointer moves, the Color Swatch 

changes to show colors that the Eye Dropper can pick up.
4 .  Click when the color you want appears in the Color Swatch. The Color Picker closes. The 

color you have clicked becomes the current color for the selected tool.

Using Eraser Tools
Big Eraser erases the entire background of your picture. Mini Eraser erases the places 
where you drag it, leaving white space. You cannot erase stickers, animations, movies, or 
text boxes with Big Eraser or Mini Eraser. (To remove these objects, select them using the 
Grab Hand tool in the Grab tray and click the Delete button on the edit frame or press the 
Delete key on your keyboard.) If you want to clear everything from the whole canvas, click 
the Trash Can.

Note: You cannot erase the foreground layer of a 3D background with Mini Eraser.

To erase the whole background of your picture:

1 .  Click the Eraser Tools button. The Erasers tray appears.

2 .  Click Big Eraser.

Big Eraser Big Eraser Effect Options

3 .  Pick an eraser effect option. You can drag the slider or click the handle at the top of the tray 
to see more effects.

4 .  Click your picture.

To erase a part of your picture:

1 .  Click the Eraser Tools button. The Erasers tray appears.
2 .  Click Mini Eraser.

Mini Eraser

Mini Eraser Size

Mini Eraser Shapes

3 .  Select a size for the eraser.
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4 .  Pick one of these shapes:
• To erase with a round outline, click the circle shape.
• To erase with a square outline, click the square shape.

5 .  Drag the eraser on the places you want to erase.
All library objects except backgrounds can be removed from the canvas by selecting them and 
pressing the Delete key on your keyboard.

Using Multi-Level Undo Guy
Undo Guy has smartened up and become better than ever. Now you can undo and redo an 
unlimited number of actions. Whenever you do something you don’t like, just click the left 
arrow as many times as you need to cancel the changes. If you change your mind and want 
to put the changes back, just click the right arrow. You can also click Undo Guy’s face once 
to undo your last action and click it again to redo that action.

In Small Kids Mode, you can only undo and redo one action by clicking Undo Guy’s face. 
The arrows are not available in this mode.

Undo Arrow Redo Arrow

Undo Guy
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Using the Text Tools
In this chapter you will learn about:

• Adding Text
• Working with Text Boxes
• Changing the Way the Letters Look
• Checking Spelling
• Checking Spelling While Typing
• Reading Text Out Loud

Adding Text
There are four ways to add text:

• Insert a text box and type text in it.
• In Small Kids Mode, add rubber stamp characters to the picture.
• Use the Letters Wacky Paint option to paint wacky text onto your picture.
• Add 2D animations from the “Alphabet” category.

Adding Text Boxes
When text is in a text box, you can check its spelling and make your computer read it out loud.

To add a text box:

1 .  Click the Text Tools button. The Text tray appears.

Copy

Cut Paste Change Pronunciation

Formatting Options

Read Out Loud

List of Voices

2 .  Click your picture where you want a text box to appear.
3 .  Start typing. The text box will grow as you fill it up.
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To cut, copy, or paste text:

1 .  Select the text within the text box.
2 .  Do one of the following:

• Cut: To cut out the text you have selected and copy it to the Clipboard, click the Cut 
button in the Text tray.

• Copy: To copy the text you have selected to the Clipboard, click the Copy button in the 
Text tray.

• Paste: To paste the text you have cut or copied, place the I-beam pointer in the text box 
where you want your pasted text to appear and click the Paste button in the Text tray.

Text in Small Kids Mode
In Small Kids Mode, adding text is like using rubber stamps. Characters become a part of the 
background. You cannot check the spelling, change the text appearance (except the color), or make 
your computer read the text out loud, but KID PIX says the characters’ names when you click them 
in the Text tray. See “Activating Small Kids Mode” on page 75.

To add text in Small Kids Mode:

1 .  Choose Turn Small Kids Mode On from the KID PIX application menu.

2 .  Click the Text Tools button. The Text tray appears.

Letter Preview

3 .  Click a character in the tray to hear its name. (To see more characters, drag the slider at the 
bottom of the Text tray.)

4 .  Click your picture to add the character.

Alphabet Text Tool
Alphabet Text becomes a part of the background. You cannot change it after you add it to your 
picture.

To use the Alphabet Text tool:

1 .  Click the Painting Tools button and select Paint Brush.

2 .  Switch to the Wacky Paint mode and choose the Letters Wacky Paint option. The 
Alphabet Text dialog appears.
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3 .  Type your text in the box. (The text you type will appear in the drawing area when you use 
the Letters Wacky Paint option of the Paint Brush tool.)

4 .  Click Done.

5 .  Click the drawing area and drag the pointer over it. The text you have typed in the Alphabet 
Text dialog appears, following the movements of your pointer.

Working with Text Boxes
You can resize a text box, move it, or delete it.

To change a text box:

1 .  Click the Grab Tools button. 

2 .  Click the Grab Hand tool. The Grab tray appears.
Copy

Grab Hand Tool

Cut

Paste Previous Object

Next Object

3 .  Click a text box to see its edit frame.

Delete

Scale

Scale

Scale

Attach Sound
Path Animation

Make Interactive
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4 .  Do any of these things:

• Move: To move the text box, simply drag it. Alternatively, you can move text boxes by 
pressing the arrow keys on your keyboard.

• Resize: To change the size or shape of the text box, drag one of the Scale handles. The 
text adjusts to the new shape.

• Rotate: To rotate the text box, drag the blue rotate lever or hold down the Command key 
and drag one of the Rotate handles that replace the Scale handles.

• Delete: To remove the selected text box, click the Delete button or press the Delete key 
on your keyboard.
Attach sound: To add a sound effect to the text box, click the Attach Sound button, and 
then record a sound, add a musical note or beat, or choose a sound from the library. See 
“Attaching Sounds to Objects” on page 52.

• Draw a path: To draw an animation path for the text box to move along, click the Path 
Animation Tool button. See “Path Animation Tool” on page 40.

• Loop path: To make your text box move along the path you have drawn over and over 
again, click the Loop Path button.

• Make interactive: To make the text box interactive — so that it will move along its path 
and have its contents read aloud only when it’s clicked — click the Make Interactive 
button so it turns green.

• Stop reading text aloud: Text in the text box will be read aloud automatically when the 
box is clicked or the project is played. This option is initially turned on. You can turn it off 
by clicking the Read Aloud button so it turns blue.

• Highlight text being read: To have KID PIX highlight each word as it is read aloud, click 
the Highlight Text button.

• Flatten: To “flatten” the text so it becomes a part of background, click the Text Tools 
button, open the Paint Zone menu, and then choose Flatten All > Text Objects if you 
want to flatten all your text boxes or Flatten Selected Object if you want to flatten just 
the selected one.

• Switch: To switch between objects, including text boxes, click the Next Object or 
Previous Object buttons or press the Tab key or Shift + Tab keys on your keyboard.

• Change layers: To move an object in front of or behind other objects, select it and 
click the button you need — Bring to Front, Bring Forward, Send to Back, or Send 
Backward.

Text Box Tips
• You can drag text boxes almost all the way off the canvas. This lets you play text out loud with-

out having text boxes appear in the picture.
• You can move and resize a text box without using the Grab Hand tool. Drag the box frame to 

move the text box, or drag the handles to resize it.

Changing the Way the Letters Look
You can change the font, font size, color, and style of your text in a text box. In Small Kids Mode, 
you can only change the characters’ color.

Note: KID PIX 5 allows you to apply different styles, fonts, font sizes, and colors to different words 
and characters in a single text box.
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To change the look of selected text in a text box:

1 .  Click the Text Tools button to see the Text tray.

2 .  In a text box, select all the text or a part of the text you want to change the look of.

3 .  Do any of these things: 

• To change the font, click the arrows next to the Font Name menu.

• To make the text bigger or smaller, click the arrows at the top and bottom of the Font 
Size gauge. You can set almost any font size you want.

• To change the style, click the Bold, Italic, or Underline buttons.

• To line up your text to the left, right, or center, click the appropriate Text Alignment 
button.

Note: Alignment is applied to the whole text in a text box.

• Use the Color Picker to change the color of the text.

Checking Spelling
When KID PIX checks spelling, it checks the selected text box. You cannot check the spelling of 
rubber stamp text in Small Kids Mode or Alphabet Text.

To check spelling:

1 .  Click the Text Tools button. The Text tray appears.

2 .  Open the Edit menu.

3 .  Choose Check Spelling.

4 .  If KID PIX finds a word it does not know, the word gets highlighted.

5 .  Control-click the highlighted word. A shortcut menu appears showing you variants for the 
word.

Checking Spelling While Typing
This feature provides a dynamic spelling check while you are typing so that you can be sure that all 
the words you type are spelled correctly. All misspelled words will be underlined with a red dotted 
line.

To turn the Check Spelling While Typing option on:

1 .  Open the Edit menu.

2 .  Choose Check Spelling While Typing so that a checkmark appears.

Reading Text Out Loud
You can “play” a picture to hear all your text read out loud. The text boxes will be read in the order  
they are positioned in the picture, from top to bottom and left to right. You can also have just one 
text box, or only a part of the text in it read aloud. You can’t have rubber stamp text in Small Kids 
Mode or Alphabet Text read out, except when you click each rubber stamp character in the Text 
tray in Small Kids Mode.
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To hear one text box read aloud:

1 .  Click the Text Tools button to see the Text tray.

2 .  Select the text box or part of the text in it you want to hear.

3 .  Click the Read Out Loud button in the Text tray.

To hear all text boxes read aloud:

Click the Play button.

To turn off text reading for a text box:

1 .  Click the Text Tools button or the Grab Tools button to see the text box frames.

2 .  Select the text box that you don’t want to be read out loud.

3 .  Click the Read Aloud button on the box’s edit frame so that the button turns blue.

Tip: You can turn off text reading for all text boxes by deselecting the Read aloud project 
text option on the General pane of KID PIX preferences. For more information, see “Setting 
Up KID PIX Preferences” on page 73.

To have words highlighted as they are read:

1 .  Click the Text Tools button or the Grab Tools button to see the text box frames.

2 .  Select the text box for which you want to turn word highlighting on.

3 .  Click the Highlight Text button on the box’s edit frame so it turns green. Now each word in 
the text box will be highlighted when it is read aloud.

Changing Voice
You can use the List of Voices menu in the Text tray to change the voice that reads your text. 

To change the voice that reads the text:

1 .  Click the Text Tools button. The Text tray appears.

2 .  Click the List of Voices pop-up menu and choose a voice.

Tip: You can adjust the way the application pronounces typed text by using different punctuation 
marks such as double-dashes, commas, and spaces to make pauses of different lengths. This way, 
the voice will have more realistic “intonation” when it reads your text.
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Teaching KID PIX to Pronounce
KID PIX might not know how to say people’s names or other special words. 

To change the pronunciation of a word: 

1 .  Click the Text Tools button. 

2 .  Click the Say It This Way button in the Text tray or choose Say It This Way from the 
Paint Zone menu. The pronunciation dialog appears.

3 .  At the left of the dialog, click the Plus button (+) to add a new word.

4 .  In the Word box at the right, type the word that KID PIX is pronouncing incorrectly.

5 .  Click in the Pronounce As box and type the phonetic spelling of the word. For example, the 
letters “ph” sound like “f”, so the phonetic spelling of “Philip” would be “Filip”. 

6 .  To listen to and compare the original and new pronunciations, click the Play buttons next to 
the Word and Pronounce As boxes. 

7 .  When the new pronunciation of the word sounds right, click Save Changes to apply it.
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Moving, Copying, Cutting, and Pasting
In this chapter you will learn about:

• Grab Hand Tool

• Scissors Tool

Grab Hand Tool
Use Grab Hand to pick objects up and move them, or cut, copy, and paste them.

To move objects around:

1 .  Click the Grab Tools button. 

2 .  Click the Grab Hand tool. The Grab tray appears.
Copy

Grab Hand Tool Make Sticker Paste

Previous and Next Objects

Flip Horizontally and Flip Vertically

Cut

3 .  Click a sticker, animation, movie, or text box in your picture to select it. 

Note: To switch between objects, click the Next Object or Previous Object buttons  
or press the Tab key or Shift + Tab keys on your keyboard.

4 .  Do any of these things:

• Move: To move the object you have selected, just drag it to the place you want. 
You can also move a selected object very slightly up, down, left, or right by pressing 
the corresponding arrow key on your keyboard, or move it much further using the 
Command+arrow key combination.

• Cut: To cut the selected object (which deletes it and copies it to the Clipboard at the same 
time), click the Cut button. 

• Copy: To copy the selected object to the Clipboard, click the Copy button. 

• Paste: To paste an object into your picture (after you have cut or copied it), click the 
Paste button.

• Change layers: To move an object in front of or behind other objects, select it and 
click the button you need — Bring to Front, Bring Forward, Send to Back, or Send 
Backward.

• Flip: To get a mirror image of the selected object, flipped from left to right or upside 
down, click the Flip Horizontally or Flip Vertically button respectively.

• Delete: To remove the selected object, click the Delete button or press the Delete key on 
your keyboard.

• Resize: To resize the selected object, drag its Scale handles. For more information, see 
“To move, change, or delete a sticker:” on page 36.
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Scissors Tool
Use the Scissors tool to cut out, move, copy, and paste a part of your background.

To cut things out:

1 .  Click the Grab Tools button. 

2 .  Click the Scissors tool. The Scissors tray appears.

Make Sticker

Cut

Paste

CopyScissors Tool

Cutout Styles

3 .  Do any of these things:

• To select an area freehand, click the Free Cutout style and drag around the area you 
want.

• To select a polygon area, click the Polygon Cutout style and drag on the canvas to draw 
the polygon’s first side. Then click to place each of the remaining points of the polygon 
(you must add at least one more point). Click the first point again to close the shape.

• To select a circle or an ellipse area, click the Circle Cutout style and drag the pointer in 
any direction you want to form a circle or an ellipse.

• To select a square or a rectangle area, click the Square Cutout style and drag the pointer 
in any direction you want to form a square or a rectangle.

Note: You can use the Shift key to select a regular circle or square area.

• To select a cookie cutter shape area, click a Cookie Cutter style, then click your picture.

4 .  After you have enclosed an area, decide how you want it to look when it’s cut out:

• If you want to make any white areas transparent, proceed to step 5. The Transparency 
button on the area’s edit frame remains blue.

• If you want white areas to be visible, click the Transparency button so that it turns 
green.
Note: The Transparency button won’t be available if you have used a Cookie Cutter 
shape.

5 .  Drag the selected area to the place you want on your picture, or you can cut or copy it using 
the Cut and Copy buttons in the tray and then paste it as a sticker with the Paste button.

To create a sticker from an area of the background:

1 .  Select an area of the background with the Scissors tool.

2 .  Click the Make Sticker button or choose Make Sticker from the Paint Zone menu.

Note: KID PIX will automatically switch to the Grab Hand tool.
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Using Libraries
In this chapter you will learn about:

• Using Library Buttons

• Backgrounds Library

• Stickers Library

• Animations Library

• Sounds Library

• Videos Library

Using Library Buttons
In the KID PIX libraries you can look in the trays for interesting objects to add to your picture. There 
are five oval buttons at the top-left of the screen. Each one opens a KID PIX library.

A background in your picture is like the scenery in a play. It goes behind everything 
else you draw. See “Backgrounds Library” on page 34.

A sticker floats above your picture like a ballon at a parade. You can resize it, flip it, 
or move it to a different place. You can also create your own stickers. See “Stickers 
Library” on page 36 and “Adding Pictures” on page 50.

Animations move around like cartoons when you “play” your picture. You can drag 
them anywhere you like. See “Animations Library” on page 38.

Each project can have three soundtracks — use them to add narration, music, and 
sound effects to your pictures. Pick a sound from the library, record your own, or 
import any available sound. See “Sounds Library” on page 44, “Adding Sounds” 
on page 51, and “Importing Sounds from iTunes” on page 56.

You can also add one or more videos to a project. Choose from the collections in the 
library, import videos created in other applications, or record your own — decked 
out in one of the cool costume frames. For more information, see “Videos Library” 
on page 46 and “Adding Videos” on page 53.

Library Trays
When you click a library button, the tray for that library appears at the bottom of the screen.

Each library contains a range of different categories. For example, if you click the Animations 
Library button and then the Categories button, you can choose the Characters category on the 
3D tab to see the collection of animated 3D characters.

To use a KID PIX library:

1 .  Click the Categories button to access all the categories in the selected library.
2 .  Click a tab depending on what kind of object you want to add, and then select a category.

3 .  Using the slider at the bottom of the tray, scroll through the objects until you find the one you 
want. You can also click the handle at the top of the tray to open it and reveal more of the 
objects.
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Backgrounds Library
Lots of things you draw are added to the background and become a part of it. For example, when 
you draw a line or paint a circle, that shape becomes a part of the background. When you change 
the background, those shapes disappear and the new background takes their place. If you don’t like 
the result, click Undo Guy.

The backgrounds are divided into four collections: full-color backgrounds (including the 3D Scenes 
category), line drawing backgrounds and special projects, map backgrounds, and video backgrounds. 
A video background is a “living backdrop” for your picture. You can draw on top of it or cut parts out 
and turn them into stickers, just like with a regular background. The video will still play when you 
play your picture.

To add a background:

1 .  Click the Backgrounds Library button to open the Backgrounds tray. 

Categories Remove Background

Background PreviewImport Image

2 .  Click the Categories button and select a background type by clicking the corresponding tab.

3 .  Choose a category from the list.

4 .  Scroll through the backgrounds by dragging the slider or expand the tray by clicking its 
handle.

5 .  Double-click the background you want or just drag it to your picture.

To remove the background from your picture:

• Click the Remove Background button in the Backgrounds tray.

If you are using a 3D background in your picture, you will need to click the Remove Background 
button twice to remove the background completely. The first click removes farther-off scenery, 
such as sky or distant objects, and the second click removes scenery that is closer to the viewer.

4 .  Select the object you want and drag it onto the drawing area. Alternatively, you can  
double-click the selected object.

Categories Object NameObject Preview

Expand Tray
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Video Backgrounds
You can use a video as the background of your KID PIX project. It can be a video from the 
Backgrounds Library or a video file imported from your computer. When the project is played, the 
video is played too.

To add a video background from the Backgrounds Library:

• In the Backgrounds Library, click the Categories button, click the Videos tab, choose a 
category from the list, and then double-click the video background you want or drag it to the 
canvas.

The video fills the canvas and starts playing in a loop. To stop playing the video background, 
click anywhere on the canvas.

To create a video background from a file:

1 .  Import a video to your project. See “Importing videos into your project” on page 49 and 
“Adding Videos” on page 53.

2 .  Choose Make Video Background from the Paint Zone menu. The video is automatically 
resized to fill the canvas and moves to the back layer.

Combining Backgrounds
Backgrounds from the 3D Scenes category can be combined with other backgrounds. Add the 3D 
background first, and then replace its back layer by adding any other background from the library 
(except for another 3D scene), an imported graphic background, or a video background. 

Some 3D Scene backgrounds are multilayered: they have a front layer with objects that you can hide 
characters in your projects behind; a middle layer, which is the scene itself where the action takes 
place; and a back layer, which appears farthest from the viewer and provides a general backdrop for 
the scene, such as sea or sky.

When combining backgrounds, the most impressive effects can be achieved by combining a 
multilayered 3D background with a video background. In this way you can, for example, transport 
your spaceship to a distant galaxy or the middle of an asteroid storm, site an American diner in front 
of the world’s most famous landmarks, or have your submarine attacked by giant goldfish!

To combine two backgrounds:

1 .  Add a multilayered background from the 3D Scenes category in the Backgrounds Library. 
You may need to experiment to find the background most suitable for your project.

2 .  Add the video background you want. See “Video Backgrounds” above.

The back layer of the 3D background is replaced with the video background you have added. 
If you want to try a different video, just repeat step 2 — you can have fun experimenting to 
find which video creates the most spectacular effect.

Importing Backgrounds
You can import images from Photos, iPhoto, or the Finder® to use them as backgrounds. 

To import a background from Photos or iPhoto: 

Click the Import Image button or choose Photo from the Import menu. For more 
information, see “Importing Pictures from Photos and iPhoto” on page 55.
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To import a background from the Finder:

1 .  From the Import menu, choose Image File.

2 .  In the dialog that appears, navigate to the picture you want to import and select it. The 
following formats are supported: BMP, GIF, JPEG, PDF, PICT, PNG, SGI, TGA, and TIFF.

3 .  Select the Import as background checkbox.

4 .  Choose one of these options:

• Fill canvas puts the picture on the canvas so that it fills the drawing area completely 
without shrinking or stretching the picture out of shape. Some parts of the image might be 
cut off.

• Fit to canvas resizes the picture without shrinking or stretching until it fits the drawing 
area either horizontally or vertically. The top and bottom or side edges of the canvas might 
be left white.

• Stretch or shrink to fill canvas stretches or shrinks the picture to fill the whole drawing 
area.

• Center puts the picture down the way it is, without stretching or shrinking it.
• Tile scales the picture down to a quarter of its original width and height (in other words, 

to one sixteenth of its original size)  and puts down lots of these smaller versions until the 
drawing area is filled.
Tip: Make sure the Show preview checkbox is selected to see how each option changes 
the way the picture is shown.

5 .  Click Import to import the picture as your new background.

Stickers Library
Stickers are graphic objects you “stick” onto your picture. They do not become a part of the 
background unless you flatten them.

To add a sticker:

1 .  Click the Stickers Library button to open the Stickers tray.

Categories Take a Photo

Import Image

Sticker Preview Sticker Name

2 .  Click the Categories button.
3 .  The stickers are divided into three collections: object stickers, flags, and buttons. Select 

a collection by clicking the corresponding tab, and then choose a category from the list.
4 .  Scroll through the stickers in the selected category by dragging the slider or expand the 

tray by clicking its handle.
5 .  Double-click a sticker you want to add or just drag it to your picture.

To move, change, or delete a sticker:

1 .  Click a sticker in your picture to select it.



37

USER GUIDE
®

Using Libraries

2 .  Do any of these things:

• Move: To move the sticker, simply drag it to the place you want. Alternatively, you can 
move stickers by pressing the arrow keys on your keyboard.

• Resize: To resize the sticker, drag one of the Scale handles. To resize it proportionally, 
hold down the Shift key while dragging.

• Rotate: To rotate the sticker, drag the blue rotate lever or hold down the Command key 
and drag one of the Rotate handles that replace the Scale handles.

• Flatten: To make the sticker part of the background, open the Paint Zone menu, and 
then choose Flatten All > Stickers & Animations if you want to flatten all your stickers 
and animations or Flatten Selected Object if you want to flatten just the selected sticker.

• Draw a path, loop the path: See “Path Animation Tool” on page 40.
• Make interactive: To make the sticker interactive — so that it will move along its path or 

play its attached sound only when it’s clicked — click the Make Interactive button so that 
it turns green.

• Attach a sound: To add a sound to the sticker, click the Attach Sound button, and then 
record a sound, add a musical note or drumbeat, or choose a sound from the library. See 
“Attaching Sounds to Objects” on page 52.

• Flip: To get a mirror image of the sticker, flipped from left to right or upside down, click 
the Grab Tools button and then click the Flip Horizontally or Flip  Vertically button 
respectively.

• Delete: To remove the selected sticker, click the Delete button or press the Delete key 
on your keyboard.

Delete

Rotate

Scale

Path Animation

Scale Scale

Attach Sound

Creating Your Own Stickers
You can make stickers from virtually anything: pictures from your Photos or iPhoto app, snapshots 
you take with your computer’s camera, objects on the canvas, and even parts of the background.

To create a sticker from a picture from Photos or iPhoto:

Click the Import Image button in the Stickers tray to open the Import Photo window, and 
then follow the steps in “Importing Pictures from Photos and iPhoto” on page 55.

To create a sticker from a camera shot:

Click the Take a Photo button in the Stickers tray to open the KID PIX Picture Booth, and 
then follow the steps in “To take an instant picture:” on page 50.
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To create your own sticker from an object or a part of background:

1 .  Add any animation or video to the canvas or select an area of the background with the 
Scissors tool.

2 .  Choose Make Sticker from the Paint Zone menu or click the Make Sticker button in the 
Grab tray.

If you are using an animation or video, the sticker will appear in the center of the canvas. If you are 
using the Scissors tool, the sticker will appear on top of the part of the background you cut out and 
KID PIX will automatically switch to the Grab Hand tool.

Using the Button Stickers
The button stickers are special stickers that act as simple navigation buttons in your projects and 
Slide Shows.

There are six kinds of button sticker:

• Next: Goes to the next project in the Slide Show.
• Pause: Freezes the playing of the project or Slide Show on the current view.
• Play: Starts playing the project or Slide Show or continues playing from the point at which it 

was stopped.
• Previous: Goes to the previous project in the Slide Show.
• Replay: Starts playing the project or Slide Show again from the very beginning.
• Stop: Stops playing the project or Slide Show and returns to the main working area.

To add a button sticker:

1 .  Click the Stickers Library button, and then click the Categories button.
2 .  Click the Buttons tab, and then select a button style in the list.
3 .  Scroll through the button stickers in the tray by dragging the slider or expand the tray by 

clicking its handle.
4 .  Double-click a button sticker to add it to your project.

When you play your project or Slide Show, clicking the button sticker will make its action happen.

Animations Library
Animations come to life when you play them. 

To add an animation:

1 .  Click the Animations Library button to open the Animations tray.

2 .  Click the Categories button and select an animation type by clicking the 2D or 3D tab.
3 .  Choose a category.
4 .  Scroll through the animations or expand the tray by clicking its handle.
5 .  Double-click the animation you want or just drag it to your picture. The animation plays 

automatically when you add it to the canvas. You can play all the animations in a picture 
by clicking the Play button located at the top-right corner of the screen.
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To move, change, or delete an animation:

1 .  Click an animation in your picture to select it.

Delete Scale

Path AnimationAttach Sound

PlayOne Frame Backward One Frame Forward

Scale

Rotate

Scale

2 .  Do any of these things:

• Move: To move the animation, drag it to the place you want. Alternatively, you can move 
animations by pressing the arrow keys or Command+arrow keys on your keyboard.

• Resize: To resize the animation, drag one of the Scale handles. To resize it proportionally, 
hold down the Shift key while dragging.

• Rotate: To rotate the animation, drag the blue rotate lever or hold down the Command 
key and drag one of the Rotate handles to which the Scale handles transform.

• Flip: To flip the animation from left to right, upside down, or both, click the Flip 
Horizontally and Flip Vertically buttons in the Grab tray.

• Flatten: To make the animation a part of the background, open the Paint Zone menu, 
and then choose Flatten All > Stickers & Animations if you want to flatten all your 
animations or Flatten Selected Object if you want to flatten just the selected one.

• Attach a sound: To add a sound to the animation, click the Attach Sound button, and 
then record a sound, add a musical note or drumbeat, or choose a sound from the library. 
See “Attaching Sounds to Objects” on page 52.

• Draw a path: To make the animation move across your picture, click the Path Animation 
Tool button. See “Path Animation Tool” on page 40.

• Loop the path: To make your animation move along the path you have drawn over and 
over again, click the Loop Path button.

• Make interactive: To make the animation interactive — so that it will move along its path 
or play its attached sound only when it’s clicked — click the Make Interactive button so 
that it turns green.

• Delete: To delete the animation, click the Delete button or press the Delete key on your 
keyboard.
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Playing Animations
You can play animations in a loop or frame-by-frame.

To play an animation in a loop:

1 .  Click the animation to select it.

2 .  Click the Play button. It changes to the Pause button.

3 .  To pause the animation, click the Pause button. It changes back to the Play button.

To play an animation frame-by-frame:

1 .  Click an animation to select it.

2 .  Click the One Frame Forward button. Each click advances the animation one frame forward.

3 .  Click the One Frame Backward button. Each click advances the animation one frame back.

Path Animation Tool
KID PIX allows you to create path animations for text blocks, stickers, videos, and animation objects 
on the canvas. You can draw looped paths that start and end in the same place to make your objects 
move in circles, or point-to-point paths that take objects from one place to another — all following 
whatever route you choose.

To create an animation path:
1 .  Click the Path Animation Tool button to enter Path Animation Mode.

2 .  Position the pointer over the object, hold down the mouse button, and drag the object 
to draw the path you want. The animation path is shown as you drag the object over the 
canvas. 

Tip: The speed at which you drag the object over the canvas will determine how fast it 
moves when you play the animation.

3 .  Release the mouse button to finish the path and leave Path Animation Mode.

If you want to leave Path Animation Mode without creating a path, just click anywhere on the 
canvas. If you want to delete a path, click the Path Animation Tool button again.

If you hold down the Shift key while drawing an animation path, the object will gradually grow 
larger, which can be used to create the impression that it is moving closer. 
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If you hold down the Command key while drawing a path, the object will rotate clockwise 
around its center as you drag it. Hold down the Control key as well to make the object rotate 
counterclockwise. This allows you to have objects “spin” across your pictures. 

Circular PathPoint-to-Point Path

Drag + Command key

Using the Auto-Perspective Effect
KID PIX automatically adds perspective to your path animations by making objects become 
gradually bigger as they move towards the bottom of the canvas and smaller as they go towards 
the top. This makes it appear that characters or objects are traveling closer to or further away 
from the viewer as they move. The auto-perspective effect is particularly impressive when used 
in combination with an appropriate background. If you don’t want to apply this effect and would 
rather have the object stay the same size while it moves along its animation path, click the Auto-
Perspective button so that it turns blue.

Looping an Animation Path
By clicking the Loop Path button, you can keep your objects continually in motion.

Usually when you play a path animation, your object will stop when it reaches the end of the path. 
But after you click the Loop button, the object will repeat the path again and again — it will go 
back and forth along a point-to-point path, turning around at each end, or round and round if the 
path is circular.
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Creating Your Own Stories
You can create single pictures that tell whole stories by using the full potential of object interactivity, 
path animation, and the 3D backgrounds, which allow objects to be placed between the foreground 
and background.

To create an animated story:

1 .  First of all drag a 3D background from the Backgrounds tray onto the canvas.

3D Backgrounds 
Category

2 .  Select an animation from the Animations tray and drag it onto the canvas.

Animations 
Category

3 .  Drag the animation around the background to find places where you can hide it. Once you 
have found a good hiding place, move your animation there.

Tip: Some of the 3D backgrounds have hiding places with transparent parts that characters 
can “peep” through. 
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4 .  Click the Path Animation Tool button and drag your animation to draw its path. To make 
your character “leave” the picture, just drag it away from the drawing area. The speed at 
which your animation will move depends on how fast you drag it when drawing the path.

Tip: To make a character stay hidden for a while and then “pop out” to surprise everybody, 
hide it behind a foreground element and draw lots of small circles when you start creating the 
animation path. After that, quickly drag it away from its hiding place and draw the rest of the 
path on the visible part of the canvas.

5 .  When you have finished drawing a path for one animation, you can add another to create 
even more fun and action-packed stories. 

Tip: If you add a lot of objects, they will be placed on different layers, with the last one you 
added in the front. To select an object that is behind other objects, you can move the ones in 
front out of the way and click the object you need. You can also switch to it by opening the 
Grab Hand tray and clicking the Next Object or Previous Object button or by pressing the 
Tab or Shift + Tab keys on your keyboard. To bring an object to the front, click the Bring 
Object to Front button.

Interactive Objects
When you play your project, all the objects you have added will usually start playing at once. Objects 
with animation paths will begin moving and sounds attached to objects and video objects will start to 
play — all at the same time. If you want to be able to decide when things happen instead, you can 
make your objects interactive. This means they will only start to move or play when you click them.

To make an object interactive:

1 .  Click a video object or an object with an animation path or attached sound to select it.

2 .  Click the Make Interactive button on the object’s edit frame so that the button turns green.
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Sounds Library
You can add sounds from the KID PIX Sounds Library, import a sound you have on your computer, or 
record your own.

To add a sound from the library:

1 .  Click the Sounds Library button to open the Sounds tray.

Categories

Import from iTunes Sound Preview Thumbnail

Sound NameRecord Sound More Sounds

2 .  Choose a sound category from the Categories pop-up menu.

3 .  Scroll through the sounds in the tray by dragging the slider or expand the tray by 
clicking its handle.

4 .  Click a sound preview thumbnail to hear the sound. The sound keeps playing until you 
click somewhere else on the screen.

5 .  When you have found the sound you want to add, double-click its preview thumbnail 
or drag it to the canvas. The thumbnail appears on the canvas and the sound starts 
playing automatically.

Remove Sound Play in a Loop

Play Sound

Sound Thumbnail

Volume

To set the volume of a sound:

1 .  Click the Sounds Library button to see the sounds you’ve added to your project.

2 .  Click the Volume button on the sound for which you want to change the volume.

3 .  Drag the Sound Volume slider that appears to set the loudness you need.

To remove the sound from your picture:

Click the Remove Sound button on the sound’s thumbnail.
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To record a sound:

1 .  Click the Sounds Library button to open the Sounds tray.

2 .  In the Sounds tray, click the  Record Sound button. A microphone and a recording timer 
appear on the screen. You can click the Record Sound button again to leave recording 
mode.

3 .  Click the Record button on the microphone to start recording.

4 .  Speak, sing, or play an instrument — make some noise!

5 .  To finish recording, click the Stop button. The Record Sound dialog appears.

6 .  Click the Play button to hear your recording. If you’re not happy with the result, click the 
Delete button, and then click the Record Sound button in the Sounds tray again. If you are 
happy with the recorded sound, give it a name and click the Save button.

Your new sound is automatically added to the picture and a sound thumbnail appears on the canvas. 
The sound is also added to the My Recordings category in the Sounds Library so you can use it 
again in other projects if you wish.

Recorded Sound 
Thumbnail

To import a sound from iTunes:

Click the Import from iTunes button or choose Song from the Import menu. For more 
information, see “Importing Sounds from iTunes” on page 56.

Multiple soundtrack

KID PIX allows you to add three soundtracks to your picture — one from the built-in Sounds 
Library, another from the My Sounds category in which your imported sounds are collected, and 
a third one from your own recordings. The soundtracks from the built-in Sounds Library and 
imported sounds will always play at a lower volume than your own recorded soundtrack. Using a 
triple soundtrack you can do things like narrating the story in your picture while music plays in the 
background and a sound effect for your main character or object is heard.

To make a triple soundtrack for your project:

1 .  Go to the Sounds Library and select a sound that suits your picture.

2 .  Drag the sound to your picture or double-click it. The sound will be added and will start 
playing.
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3 .  If you want to add a soundtrack you recorded earlier, add it from the My Recordings 
category and go on to step 6. If you want to record a new soundtrack, click the Record 
Sound button in the Sounds tray.

4 .  Click the Record button on the microphone and record your soundtrack. Click the Stop 
button to stop recording.

Tip: When recording, you can tell the story happening in your picture, give your characters 
voices, make sound effects, play an instrument, or do whatever else you like.

5 .  Give your soundtrack a name so you can find it again in the My Recordings category and 
click the Save button to save your soundtrack.

6 .  Add a sound from your computer using either the Sound File command from the Import 
menu or the Import from iTunes button.

7 .  Now your picture has three soundtracks! 

To remove a sound from the My Sounds or My Recordings category:

1 .  Click the Categories button and choose the My Sounds or My Recordings category.

2 .  Expand the Sounds tray by clicking the handle at the top.
3 .  Select the sound you want to delete by clicking it so that it has a checkmark. To select 

several sounds, click them in turn while holding down the Command key.

4 .  Click the Trash Can icon at the bottom of the tray.

5 .  Click Delete in the alert that appears.

Selected Sound Selection Mark

Expand Tray

Unselected Sound

Trash Can

Videos Library
The Videos tray allows you to add videos from the library to your project, import videos, record your 
own, and even put them into fun-looking frames.

There are over a hundred videos to choose from in the KID PIX galleries.

To add a video to your project from the library:

1 .  Click the Videos Library button to open the Videos tray.

2 .  Click the Categories button, click the Videos tab, and choose a category.

3 .  Scroll through the video thumbnails by dragging the slider or expand the tray by 
clicking its handle.
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Categories

Import Video 

Record Video

Video Preview

Video Name

4 .  Add the video you want by double-clicking its thumbnail or by dragging it to the canvas. The 
video starts playing automatically.

When you have added a video, you can move, change, or delete it in the same way as you do with 
animations.

If the video that you have added has sound, you may want to adjust the volume to make it louder or 
quieter when the video is played.

To set the volume of a video:

1 .  Select the video for which you want to change the volume.

2 .  Click the Volume button and drag the Video Volume slider that appears to set the loudness 
you need.

Video narration

KID PIX allows you to record your own videos. You can appear onscreen narrating your animated 
story, and even dress for the part in one of the fun costume frames. You must have a camera and 
microphone built in or connected to your Mac in order to use the Video Narration feature.

To record your own video:

1 .  Choose Video Narration from the Import menu or click the Record Video button in 
the Videos tray. The KID PIX Video Booth opens.

Record

Camera Choices

Frame Options

Back to Paint Zone

No Frame

Frame Categories

Zoom slider
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2 .  If you have an external camera and/or microphone connected to your computer in addition 
to the built-in devices, choose the video and audio source you want to use by clicking the 
corresponding button or buttons.

3 .  Select a costume frame or picture frame.

You can click the Frame Categories button and choose another category to see different 
frames. Drag the slider at the bottom of the tray or click the handle at the top of the tray 
to see more options in each category. Click the No Frame option if you want to record your 
video without a frame.

Note: Because of the way your computer displays video camera images, the costume frames 
are shown as mirror images in the Video Booth. They will appear the other way around when 
placed in your projects.

4 .  Drag the Zoom slider to zoom the camera view in and out until your face or the scene fits 
nicely in the frame.

5 .  Click the Record button. After a three-second countdown, recording begins. To stop 
recording, click the Record button again.

6 .  To preview your video, click the Play button.

7 .  To add the recorded video to your picture, click the Add to Project button.

Adding a frame to your video

You can also add a frame to any video object you have already placed on the canvas.

To add a frame to a video:

1 .  Select the video to which you want to add a frame.

2 .  In the Videos tray, click the Categories button, and then click the Frames tab.

3 .  Click the Adventure, Everyday, and Fantasy categories to see all the different frames.

4 .  Double-click the frame you want or drag it to the canvas.

To create a sticker from a video or animation:

1 .  Add a video or animation to the canvas.

2 .  Play the video or animation and pause it on any frame that you want to use as a sticker.

3 .  Choose Make Sticker from the Paint Zone menu or click the Make Sticker button in the 
Grab tray.

The frame will be added to the selected video, and the two objects will be merged into one so that 
you can move, resize, and animate them together.
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Importing videos into your project

1 .  Click the Import Video button in the Videos tray, or choose Video from the Import 
menu. The Import Video window appears.

2 .  Look through the videos from your Movies folder and iTunes and Photos libraries.

3 .  Select the video you want, and then click Import.

Tip: To make the video fill the canvas and use it as the background of your project, select the 
Import as background checkbox in the Import Video window. The video will be enlarged and 
sent to the back layer of the picture. Now you can draw and paint on it, add objects, or cut parts out 
and turn them into stickers — the video will still play when you play your project.

You can also import video files which are not in your media libraries from your computer’s hard disk 
or other media. For more information, see “Adding Videos” on page 53.
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Adding Stuff to Your Project
In this chapter you will learn about:

• Adding Pictures

• Adding Sounds

• Adding Videos

Adding Pictures
In KID PIX 5 you can use your computer’s camera to take instant pictures that become stickers in 
your projects. Photographs and pictures you create with other applications can also be imported. You 
can resize and animate the pictures you add, or you can flatten them and then paint on them and 
add special effects.

To import a picture file as a sticker:

1 .  From the Import menu, choose Image File.

2 .  Navigate to the picture you want to import and select it. The following formats are supported: 
BMP, GIF, JPEG, PDF, PICT, PNG, SGI, TGA, and TIFF.

3 .  Choose one of these options:

• Fill canvas makes a sticker that fills the canvas without shrinking or stretching the picture 
out of shape. Some parts of the image might be cut off.

• Fit to canvas resizes the picture without shrinking or stretching to make a sticker that fits 
the drawing area either horizontally or vertically.

• Stretch or shrink to fill canvas stretches or shrinks the picture to make a sticker that 
fills the whole drawing area.

• Center makes a sticker of the picture the way it is, without stretching or shrinking it.

• Tile scales the picture down to a quarter of its original width and height (in other words, to 
one sixteenth of its original size) and uses lots of these smaller versions to make a sticker 
that fills the drawing area.

4 .  Make sure the Import as background checkbox is not selected.

5 .  Click Import to add the image to your KID PIX picture.

To take an instant picture:

You must have a camera built in or connected to your Mac in order to take pictures.

1 .  Click the Take a Photo button in the Stickers tray. The KID PIX Picture Booth opens.

2 .  If you have an external camera connected to your computer as well as a built-in 
camera, click the Choose Camera button and select which one you want to use.

3 .  Select a costume frame or picture frame. Click the No Frame option if you want to 
take a picture without a frame.

4 .  Drag the Zoom slider to zoom the camera view in and out until your face or the scene 
fits nicely in the frame.

5 .  When you’re ready to take the photo, click the Snap button.
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6 .  The screen changes to show you your photo. If you’re not happy with it, click the Try Again 
button to have another go. If you like the photo, click the Add to Project button. Your photo 
appears on the canvas as a sticker.

Adding Sounds
You can import a background sound for your entire project and attach sounds to particular objects.

To import a sound for the entire project:

1 .  Choose Sound File from the Import menu. Alternatively, you can import a sound directly 
from iTunes. For more information, see “Importing Sounds from iTunes” on page 56.

2 .  Find the sound file you want to import and click it. With KID PIX, you can import sound files 
in the following sound formats: AIFF, WAV, MP3, AU, and AAC.

3 .  Click Open to add the sound to your project. An imported sound thumbnail appears on the 
canvas and the sound starts playing automatically.

Note: If the Sounds tray was open when you performed the import, the My Sounds 
category will automatically be chosen and the imported sound will be selected in the tray.

Imported Sound 
Thumbnail

Snap

Camera Choices

Frame Options

Back to Paint Zone

No Frame

Frame Categories
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Attaching Sounds to Objects
Besides adding sounds to your entire project (see “Sounds Library” on page 44 and “Adding 
Sounds” on page 51), you can attach a sound to any object, be it a sticker, an animation, a video, 
or a text box. These sounds are played when you play the project or, if the object is interactive, 
when the object is clicked (see “Interactive Objects” on page 43). Each object in your project can 
have one sound attached.

To attach a sound to an object:

1 .  Select an object.

2 .  Click the Attach Sound button on the object’s edit frame.

3 .  In the Sound window that appears, click the Record, Instrument, or Library tab.

4 .  Add your sound:

• In the Record pane you can record voices, music, or sound effects using a built-in 
microphone or a microphone connected to your computer. Click the red Record button 
and speak, sing, or make other sounds. Click the button again when you want to stop 
recording.

• In the Instrument pane, add a musical note or drumbeat using one of the musical 
instruments: a piano, guitar, or drum kit. Select the instrument you want to play, and then 
click an onscreen key or a drum or cymbal.

Remove All SoundsVolume
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• In the Library pane, select a sound from the collection by clicking its thumbnail.

5 .  Drag the Volume slider to set the loudness of the sound.

6 .  Click anywhere on the canvas. The sound is now attached to the object.

To listen to the attached sound:

1 .  Select an object to which a sound is attached (one where the Attach Sound button is 
green).

2 .  Click the Play button on the object’s edit frame.

To remove an attached sound:

1 .  Select an object to which a sound is attached.

2 .  Click the Attach Sound button on the object’s edit frame.

3 .  Click the Remove All Sounds button.

Adding Videos
You can add videos in the MP4, M4V, and MOV formats to your KID PIX projects.

To import a video file:

1 .  Choose Movie File from the Import menu.

2 .  In the dialog that appears, find the file you want to import and click it.
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3 .  If you want to use the video as the background of your picture, select the Import as 
background checkbox. If you cannot find this checkbox, click the Options button.

4 .  Click Import to add the video to your picture.

Playing Videos
You can play videos in a loop or frame-by-frame. Videos are also played in a loop when you play your 
whole project.

To play a video in a loop:

1 .  Click the video to select it.

2 .  Click the Play button. It changes to the Pause button.

3 .  To pause the video, click the Pause button. It changes back to the Play button.

To play a video frame-by-frame:

1 .  Click the video to select it.

2 .  Click the One Frame Forward button. Each click advances the video one frame forward.

3 .  Click the One Frame Backward button. Each click advances the video one frame back.

Video Tips

• When you print your picture, the video frame you see is the one that will be printed. You can 
play the video frame-by-frame and stop it when it looks the way you want it to be printed.

• To make the video fill the canvas and use it as the live background, choose Make Video 
Background from the Paint Zone menu. The video will be sent to the back layer of your 
picture.

• To make a video part of the background, choose Flatten Selected Object from the Paint 
Zone menu. To flatten all movies, choose Paint Zone > Flatten All > Movies.

• You can add multiple videos to the canvas and play up to three of them at the same time. (If 
you have three videos playing and start playing another, one of the three currently playing will 
stop.)
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Integration with iApps
You can import pictures directly from your Photos or iPhoto albums and add favorite tracks directly 
from your iTunes playlists.

In this chapter you will learn about:

• Importing Pictures from Photos or iPhoto

• Importing Sounds from iTunes

Importing Pictures from Photos and iPhoto
You can browse through your digital photo albums directly from KID PIX. Photographs you store 
in your Photos and iPhoto libraries can become a part of your KID PIX picture.

To import a picture from Photos or iPhoto:

1 .  Click the Import Image button in the Backgrounds or Stickers tray, or choose Photo from 
the Import menu. The Import Photo window appears.

Note: If you have moved, renamed, or deleted the Photos or iPhoto library that was stored in 
the default location (the folder /Users/username/Pictures/Photos Library or /Users/
username/Pictures/iPhoto Library), you will need to restore it to this location to be able 
to import photos from it.

2 .  Choose one of your photo albums and select the picture you want to import.

3 .  Select the Import as background checkbox if you want to import the image as a 
background.
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4 .  Select one of these options:

• Fill canvas puts the picture on the canvas so that it fills as much of the drawing area as 
possible without shrinking or stretching the picture out of shape.

• Fit to canvas resizes the picture without shrinking or stretching until it fits to the drawing 
area. The edges of the drawing area might be left white.

• Shrink or stretch stretches or shrinks the picture to fill the whole drawing area.
• Center puts the picture down the way it is, without stretching or shrinking it.
• Tile scales the picture down to a quarter of its original width and height (in other words, 

to one sixteenth of its original size) and puts down lots of these smaller versions until the 
drawing area is filled.

5 .  Click Import to import your photo. It will be added to the currently open KID PIX project.

Importing Sounds from iTunes
You can browse through your iTunes playlists directly from KID PIX and attach your favorite sounds 
to your picture. Audio tracks cannot be imported directly from an audio CD. You should first import 
them to iTunes.

To import sounds from iTunes:

1 .  Click the Import from iTunes button in the Sounds tray, or choose Song from the 
Import menu. The Import Sound window opens.

2 .  Select a playlist, and then select the song you want to import.

Note: If you have moved, renamed, or deleted the iTunes library file that was stored in the 
default location (the folder /Users/Username/Music/iTunes), you will need to restore it 
to this location to be able to import sounds from your iTunes playlists.

3 .  To listen to the track you have selected before importing it, click the Play button. To listen 
to it playing in a loop, click the “Loop music” checkbox so that a checkmark appears.

4 .  Select one of the radio buttons in the Import group. Click the first option to import the 
entire song. Click the second option to import just a fragment, the length of which can be 
chosen from the pop-up menu. The preset length of an imported fragment is 5 seconds.

5 .  Select the checkbox labeled “Fade out at end” if you want the song or song fragment you 
import to fade out gradually when it reaches the end and not finish abruptly.

6 .  To import your song or song fragment, click the Import button. The imported song or song 
fragment is added to the currently opened KID PIX picture and starts playing immediately.

For information on using the Sounds Library, see “Sounds Library” on page 44.
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Working with Projects
In this chapter you will learn about:

• Starting Your New Project

• Saving Your Project

• Saving Your Project as a Template

• Opening Your Project

• Playing Your Project

• Printing Your Project

• Exporting Your Project

Starting Your New Project
You can start with a blank page or use the Idea Machine like an electronic coloring book.

To start with a blank page:

Click the Create New Project button. KID PIX automatically saves the project that is 
already open and creates a new project.

To use the Idea Machine:

1 .  Click the Templates button.

2 .  In the window that appears, click the Idea Machine tab. 

3 .  Double-click the picture template you want to use. KID PIX automatically saves the 
project that is already open and creates a new project from the template.

Saving Your Project
By default, KID PIX saves your work in the My Projects folder (Home installation) or in the system 
user’s Documents folder (School installation). This makes your projects easy to find and open 
again.

The My Projects folder is located in the KID PIX user folder, which is stored in the KID PIX Users 
folder within the Documents folder of the current system user. You can change the saving location 
using the General pane of KID PIX preferences. 

To save changes to a project:

Choose Save from the File menu. KID PIX saves your project.

To save a project under a different name:

If you want to leave the original picture without changes, choose Save As from the File menu and 
save the picture with the changes you have made as a new picture with a new name.
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Saving Your Project as a Template
You can save your project as a template. This allows you to create different versions of your picture 
based on the template while the original project remains unchanged. You can also add your template 
to the Templates collection. This way you can easily access your template projects by clicking the 
Templates button and then clicking the Teacher Templates tab.

To save a project as a template:

1 .  Choose Save as Template from the File menu.
2 .  Type a name and select a location for your project.
3 .  If you want your project template to appear in the Templates collection, make sure the Also 

add to Teacher Templates checkbox is selected.
4 .  Click Save.

Note: If you already have a template with the same name, KID PIX asks whether you want 
to replace the old template with the new one.

Opening Your Project
You can open any project you have created and saved.

To open a project you saved earlier:

1 .  Choose Open from the File menu.
Note: If you have not saved changes made to the project that is already open, KID PIX will 
save them automatically before opening the other project.

2 .  In the dialog that appears, select the project you want to open.
3 .  Click Open.

Playing Your Project
If your project contains stickers or text with path animation applied, animations, movies, or sounds, 
you can “play” the picture to bring it to life.

To play your project:

1 .  Click the Play button.

All the tools disappear from the screen, your project’s canvas expands to occupy the 
entire available area, and the project starts playing.

Note: All animations will start to play at once. All videos will start to play and all objects 
with animation paths will start to move as well unless you have made them interactive. 
See “Interactive Objects” on page 43.

2 .  To stop playing the project, click the Leave Play Mode button in the top-right corner of 
the canvas.

The project stops playing and the tools return to their positions.



59

USER GUIDE
®

Working with Projects

Printing Your Project
You can print a KID PIX project in a regular size or as a poster.

KID PIX prints the frames of movies and animations that are shown at the moment that you print.

Note: KID PIX does not print in Small Kids Mode. To be able to print, turn Small Kids Mode off by 
choosing the Turn Small Kids Mode Off command from the KID PIX application menu.

 To print your project:

1 .  Click the Print button or choose Print from the File menu. The Print dialog appears.

Note: If you don’t see the Options pop-up menu or other additional settings, click the Show 
Details button at the bottom of the dialog.

2 .  With KID PIX chosen from the Options pop-up menu, set the following options as you need:

• Fit to page scales the picture to fit the paper size.
• Full page prints the picture on one separate page.
• Poster 2x2 pages prints your picture on four sheets of paper.
• Poster 3x3 pages prints your picture on nine sheets of paper.

When you print your picture as a poster, KID PIX prints parts of it on separate sheets of 
paper. You can then tape the sheets of paper together to make the poster.

3 .  Click Print to print the picture.

Tip: You can turn your picture into a T-shirt transfer by choosing Layout from the Options pop-up 
menu and selecting the Flip horizontally checkbox. This makes a mirror image of the picture that 
you can then print on special transfer paper.

Options menu
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Exporting Your Project
You can export your KID PIX project to another file format to open it without KID PIX. For example, 
if you save your KID PIX picture as an image in PNG format, you can add it to a web page or attach 
it to an email and send it to family and friends. To retain animation, movies, and sounds in your 
picture, export it as a movie. To retain interactivity as well as motion and sound, export it as an 
HTML5 page.

To export your project:

1 .  Choose Export from the File menu.
2 .  In the dialog that appears, type a name for your exported project.
3 .  Choose the location where you want to save your exported project.
4 .  Choose Current Project from the Export pop-up menu.
5 .  Choose an export format from the Format pop-up menu: 

• Image: Everything in the picture is flattened. KID PIX will create an image in PNG format.
• Movie: The exported file can be played on almost any kind of computer with a video 

player installed.
• HTML5 Page: A web page will be created, which you can open in most modern web 

browsers on virtually any computer or device. It retains all the interactivity, animations, 
sounds, and videos you have added to your project. The export creates a folder with the 
same name as your project and containing two key items — an index .html file, which 
should be double-clicked or tapped to open the web page with the project; and a data 
subfolder, which you should not rename, remove, or delete.

6 .  If you are exporting your project as a movie, choose an option from the Quality pop-up 
menu. The higher the quality, the larger the exported file will be.

7 .  Click Export.
Note: If you select the Add to Photos Library when exporting checkbox, your exported 
image or movie will be added automatically to your Photos library.
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Working with the Gallery
The Gallery is the place where all your projects are stored. Here you can access any project or Slide 
Show that you have saved. 

To access the Gallery and open a project or Slide Show:

1 .  Click the Gallery button at the top of the Paint Zone or the Slide Show area.

2 .  Select any of the display areas:

• My Projects — displays thumbnails of the pictures you have created and saved in the 
Paint Zone.

• My Slide Shows — shows your saved Slide Shows.

• My Templates — if you have saved any projects as templates, they will appear here.

• My Small Kids Projects — all projects created in Small Kids Mode are stored here.

• Recents — shows the projects you have had open most recently.

3 .  Select the project or Slide Show you want to open and click Open.
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Working with Slide Shows
In this chapter you will learn about:

• Creating and Opening Slide Shows
• Adding Projects to Slide Shows
• Editing Projects in Slide Shows
• Moving Projects Around
• Playing Your Slide Show
• Customizing Your Slide Show
• Adding a Voiceover to Your Slide Show
• Printing Your Slide Show
• Saving Your Slide Show
• Exporting Your Slide Show
• Creating Animations with Slide Shows

Creating and Opening Slide Shows
You can make a Slide Show from your projects. Load your projects into the Slide Show and put them 
into any order you like. Then set transition and audio options and play the Slide Show or export it as 
a movie. You can also print it.

The projects in your Slide Show are shown in the Tube at the right of the Paint Zone and in the 
Slide Show area. You can create a brand new Slide Show or open an existing one from the Gallery .

To create a new Slide Show:

1 .  Click the New button at the top of the Slide Show area.

2 .  Add projects to the Slide Show. For details, see “Adding Projects to Slide Shows” below.

To open an existing Slide Show:

1 .  Choose Open from the File menu.

2 .  In the dialog that appears, go to the Slide Show that you want to open and select it. KID PIX 
Slide Show files have the  .kpalbum filename extension.

3 .  Click Open.

Adding Projects to Slide Shows
When you create a new project or open an existing one, it is not added to a Slide Show 
automatically. If you want a project to be included in a Slide Show, you need to add it yourself.

To add a project to a Slide Show from the Paint Zone:

1 .  Make sure the Slide Show to which you want to add a project is in the Tube. If the Tube is 
empty, you can start a new Slide Show.

2 .  With your project open on the canvas, click the Add to Slide Show button at the top of the 
Tube or choose Add to Slide Show Tube from the Paint Zone menu.
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To add a project to a Slide Show from the Slide Show area:

1 .  Make sure the Slide Show to which you want to add a project is open in the Slide 
Show area. If no Slide Show is open, you can start a new one.

2 .  Click the empty [+] slide in the Slide Show area to open the folder containing your 
saved projects.

3 .  Select the project you want to add, and then click Open.

Note: Whichever place you add a project from, its thumbnail will appear in both 
the Tube and a new slide in the Slide Show area. 

Editing Projects in Slide Shows
To make changes to a project you have already added to a Slide Show, do one of the following:

• Click its thumbnail in the Tube in the Paint Zone. 

• Double-click its thumbnail in the slide in the Slide Show area. 

• Select the slide in the Slide Show area, and then click the Edit Slide icon that appears at the 
top of the slide’s frame.

The project opens on the canvas in the Paint Zone and you can make your changes.

Moving Projects Around
When your Slide Show is played, projects are played in the order they appear in the Tube or Slide 
Show area. You can move projects into any order you want.

To move a project in the Tube or Slide Show area:

Drag the thumbnail of the project that you want to move up or down in the Tube or anywhere in the 
Slide Show area.

To delete a project from your Slide Show:

• In the Paint Zone, drag the thumbnail of the project out of the Tube.

• In the Slide Show area, drag the slide with the project out of the Slide Show to the Trash 
Can, or select the slide and click the Trash Can.

Saving Your Slide Show
By default, KID PIX saves your Slide Show files in the My Slide Shows folder (Home installation) or 
in the system user’s Documents folder (School installation). This makes your Slide Shows easy to 
find and open again.

The My Slide Shows folder is located in the KID PIX user folder, which is stored in the KID PIX 
Users folder within the Documents folder of the current system user. You can change the saving 
location using the General pane of KID PIX preferences.

To save changes to a Slide Show:

Click the Save button or choose Save from the File menu. KID PIX saves your Slide Show.
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To save a Slide Show under a different name:

If you want to keep a Slide Show as it is but create an identical one with a different name, which you 
can then make changes to if you wish, choose Save As from the File menu.

Playing Your Slide Show
When you play a Slide Show, the projects you have added to it are played one after the other with 
any transition effects and sounds you have set in between.

To play your Slide Show:

1 .  Click the Play Slide Show button. Your Slide Show occupies the entire available area and 
starts playing.

2 .  To stop playing the Slide Show, click the Leave Play Mode button in the top-right corner.

The Slide Show stops playing and the tools return to their positions.

Note: By default, a Slide Show plays only once, but it can be played continuously until you 
manually stop it.

To play a Slide Show continuously or just once:

Flick the Loop Play switch to On to play your Slide Show continuously, starting it 
again from the first slide after playing the last one, or switch it to Off to play the Slide 
Show only once. The switch is located at the bottom of the Slide Show area.

Using Manual Advance
Manual advance lets you advance the slides manually, while keeping your visual and sound transition 
effects in place.

To use manual advance:

1 .  From the Slide Show menu, choose Turn Manual Advance On.

2 .  Play a Slide Show by clicking the Play Slide Show button.

3 .  Click anywhere on the slide or press any key to advance to the next slide.

Customizing Your Slide Show
You can set slide advance options and add visual transition and sound effects to give your Slide Show 
a really exciting, unique appearance. For more information about transition effects, see “Transition 
Options” below. For information on attaching sounds to your Slide Shows, see “Adding Background 
Sound” on page 66.

Setting Up Transition Options
Transition options tell KID PIX when to stop playing one project in your Slide Show and move on to 
the next. You can tell KID PIX to display the next project after a certain number of seconds, or to 
wait until all the text in the project has been read aloud, or until the music or sound ends, or until 
you click with the mouse. You can also choose how KID PIX advances to the next project by choosing 
from the collections of visual transition effects and sounds.
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• Random: This preset style uses a random transition effect from the collection to advance 
to the next project. Each project is displayed for 3 seconds.

• Custom: Allows you to choose a transition effect from the collection and set your own 
conditions for when KID PIX should advance to the next project.

3 .  If you have chosen the Custom transition style, use these options to set it up:

• Transition: Select a visual transition effect. If you do not want to have any transition 
effects, click the No Transition option. Click the Random Transition option if you want 
to have different transition effects applied at random.

• Sound: Choose a sound effect for the transition. Click any sound to listen to it. Choose 
Random Sound from the end of the list if you want to have different sounds played at 
random during different transitions.

• Audio options: Use the audio options to tell Slide Show to play all the project’s sounds 
and text, or not to play any audio at all.

• Select Play Sound to tell Slide Show to play the sound attached to this project.
• Select Play Text to tell Slide Show to read the text of this project out loud.

• Go to next slide: Tells KID PIX what event it should wait for before displaying the next 
project in the Slide Show. The options are:

To set up a transition style:

1 .  Click the Slide Show Style button.

2 .  Select a transition style. There are four options:

• Flipbook: This preset style displays each project slide in your Slide Show for 0.1 seconds 
without transition effects. This option is very handy for creating your own simple “frame-
by-frame” animations. See “Creating Animations with Slide Shows” on page 70.

• Storybook: This preset style displays a project until all the objects in it have finished 
playing, and then advances to the next project. The transition effect used gives the 
impression of turning pages in a book.
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• After [number] seconds lets you enter the number of seconds for which each 
slide will be displayed. Choose this option if you are planning to export your Slide 
Show later as a movie. See “Exporting Your Slide Show” on page 69. 

• On click tells KID PIX to wait until you click with the mouse before the next slide is 
displayed.

• On pressing any key tells KID PIX to wait until you press any key on your 
keyboard before the next slide is displayed.

• When sound ends tells KID PIX to wait until a specified type of sound in the 
project is played before it advances to the next slide. You can specify a sound from 
the Sounds library, an imported sound, a sound you have recorded yourself, or any 
combination of the three.

• When text reading ends tells the application to read all the text in the picture and 
then display the next slide.

• When all objects played makes KID PIX display each project until all movies, 
animations, path animations, sounds, and other objects in it have finished playing. 
Only after that will KID PIX move on to play the next project.

4 .  Click Apply to Selected to apply your settings only to the currently selected slides, or click 
Apply to All to apply them to all the slides in your Slide Show.

Adding Background Sound
Use the sound options to add background music or another sound that will play right through your 
whole Slide Show. You can use one of the sounds that come with KID PIX or a favorite song from 
your iTunes library. The background music will play in addition to any sounds you have added to the 
projects in your Slide Show.
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3 .  On the Sounds pane you can add one of the sounds that come with KID PIX. Select 
a category from the list on the left and then select the sound you want on the right. 
Or, if you want to use a sound from your iTunes library, click the iTunes Music 
button. KID PIX will display the contents of your iTunes library. Select the song you 
want to use.

4 .  Tell KID PIX what to do with the sound or song you have selected:
• Select Play entire song to tell KID PIX to play the sound right through from beginning to 

end.

• Select Play first [number] seconds to tell KID PIX to play the sound from the beginning 
and stop playing it when the specified time expires.

• Select Fade out at end to have the volume of the sound gradually decreased as it nears 
the end.

5 .  Click the Play button to hear the selected sound with the results of any changes you made in 
step 4.

6 .  Click Apply to add the selected sound as the background music of your Slide Show.

Adding a Voiceover to Your Slide Show
In addition to background music, you can record a full-length voiceover for your Slide Show. You can 
narrate and tell the story of what is happening onscreen, give voices to characters in your projects, 
or anything you wish. The voiceover will be heard in the background when your Slide Show is played.

To set up background music:

1 .  Click the Background Sound button.
2 .  Click the Sounds tab.
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Changing Background Color
Slides in a Slide Show appear on a solid color background. You can change this color.

To change the background color for the current Slide Show:

1 .  Click the Background Color button or choose Change Background Color from 
the Slide Show menu.

2 .  Pick a color and click Save.

To record a Slide Show voiceover:

1 .  Click the Voiceover button.

2 .  Click the Record button. KID PIX enters Play 
mode so you can see your Slide Show play as you 
make your voiceover. A microphone is also shown 
indicating that sound will be recorded, and a three-
second countdown begins.

3 .  When the countdown ends, start speaking.
4 .  Click the red light on the microphone when you want to stop 

recording.

5 .  Click Listen to listen back to your voiceover. You can change 
the volume by dragging the Volume slider. If you’re not happy 
with your voiceover, click the Delete (trash can) button to 
remove it or click Record to make a new one. If you record a 
new voiceover, the previous one you made will be deleted.
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Printing Your Slide Show
You can print each project in your Slide Show separately on its own page, or you can print several 
smaller sized views of the projects on one page.

To print your Slide Show:

1 .  Click the Print button at the top of the Slide Show area or choose Print from the File menu. 
The Print dialog appears.

2 .  Select one of these formats:
• Full page prints each project slide on a single separate page. Type the number of the slide 

or range of slides you want to print in the From and to boxes.
• Storybook prints two slides on each page.
• Comic book prints six slides on each page, with the slides placed in two rows of three in 

horizontal page orientation and three rows of two in vertical orientation.
• Card / booklet prints four slides per page. Slides are placed in two rows of two, one of 

which is upside down. When you have printed the page, you can fold it in quarters to make 
a fun greeting card. You can also create a Slide Show of four projects but leave three of 
them empty. You can then print the Slide Show to get a card with a picture on the front 
panel only, with the other panels free for writing on.

• Thumbnail prints twenty-four slides on each page, placed in four rows of six in horizontal 
page orientation and six rows of four in vertical orientation.

3 .  Click Print to print the Slide Show.

Exporting Your Slide Show
You can export your Slide Show to view or play it on another computer with or without KID PIX. 

To export a Slide Show:

1 .  Choose Export from the File menu.
2 .  In the dialog that appears, type a name for the exported Slide Show.
3 .  Choose the location where you want to save your exported Slide Show.
4 .  Choose Entire Slide Show from the Export pop-up menu.
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5 .  Choose an export format from the Format pop-up menu: 
• Image Sequence: Everything in every project in your Slide Show is flattened. KID PIX 

will create a sequence of images in PNG format.
• Movie: The exported file can be played on almost any kind of computer that has a video 

player installed.
• HTML5 Page: A web page will be created, which you can open in most modern web 

browsers on virtually any computer or device. It retains all the interactivity, animations, 
sounds, and videos you have added to the projects in your Slide Show. The export creates 
a folder with the same name as your Slide Show and containing two items—an index .html 
file, which should be double-clicked or tapped to open the web page with the Slide Show; 
and a data subfolder, which you should not rename, remove, or delete.

6 .  If you are exporting your project as a movie, choose one of the options from the Quality 
menu. The higher the quality, the larger the file.

7 .  Click Export.

Creating Animations with Slide Shows
You can create simple frame-by-frame animated cartoons by adding slightly modified versions of a 
picture one by one to a Slide Show and then using the Flipbook preset to play it.

To create an animation frame by frame:

1 .  In the Paint Zone, create a new project and draw a simple picture, or add one or more 
objects (stickers, text, and so on) that you want to animate.

2 .  Click the Add to Slide Show button. A new Slide Show will be created and your 
picture will be added to the Tube as the first slide. (If there are already slides in the 
Tube, go to the Slide Show area and click the New button at the top to start a fresh 
Slide Show.)

3 .  Make a small change to your drawing, or modify the added object or objects slightly 
(move and resize them a little bit, change the color, and so on).

4 .  Click the Add to Slide Show button again. Your modified picture will appear in the 
Tube as the second slide in your Slide Show.

5 .  Repeat steps 3 and 4 to create more frames for your animation. 

6 .  When you have finished adding slides, go to the Slide Show area.

7 .  Click the Slide Show Style button. 

8 .  At the top of the Slide Show Style dialog that appears, click the Flipbook option. 
This preset option has all the transition settings you need for a frame-by-frame 
animation: the transition effect changes to No Transition, with no transition sound, 
and the time after which the next slide is shown changes to 0 .1 seconds.

9 .  Click the Apply to All button to apply the settings to all the slides in the Slide Show, 
and then click the Play Slide Show button. Your Slide Show will play as an animated 
cartoon.

10 .  To get a cartoon you can play on almost any computer, export your Slide Show as a 
movie or an HTML5 page. See “Exporting Your Slide Show” on page 69.
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Publishing to YouTube
You can share the projects and Slide Shows you make in KID PIX with the whole world by uploading 
them straight to YouTube as movies. Please note that you must have a YouTube or Google™ account 
and your Mac must be connected to the Internet to be able to use this feature.

To publish your movie to YouTube:

1 .  Choose Share to YouTube from the File menu. The Log In to YouTube dialog appears.

2 .  Enter the email address and password that you use for your YouTube or Google account, and 
then click the Sign In button.

3 .  Click Allow in the window that appears next to allow KID PIX to publish to your YouTube 
account.

4 .  Choose a category and enter a title, a description, and search tags for your movie.

5 .  Select the “Make the movie personal” option if you want to limit access to your movie on 
YouTube, and then click Next.

6 .  The YouTube Terms of Service appear. Read through them and click the Share button to 
publish your movie.
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7 .  Wait until the movie is uploaded to YouTube.

8 .  A link to your movie will appear. Click the View button to watch your movie on              
www.youtube.com, or click OK to go back to the Paint Zone.

Logging In to YouTube Automatically
If you don’t want to enter your account details every time you publish a movie to YouTube, sign in 
using the Sharing preferences.

To have KID PIX sign you in to YouTube automatically:

1. Choose Preferences from the KID PIX application menu.

2. Click the Sharing tab.

3. Select YouTube in the left part of the dialog.

4. Click the Sign In button.

5. Enter the email address that you use for your YouTube or Google account, and then click Next.

6. Enter your password, and then click Sign in.

7. Click Allow.

KID PIX will now publish your movies to YouTube without your needing to enter your email address 
and password each time.

To sign out from YouTube at any time, open the Sharing pane of the Preferences again and click 
Sign Out.

http://www.youtube.com/
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Options for Parents and Educators
In this chapter you will learn about:

• Setting Up KID PIX Preferences
• Activating Small Kids Mode
• Using Full-Screen View
• Controlling Sound
• Preventing Accidental Internet Access
• Administrating the Login Dialog

Setting Up KID PIX Preferences
Using the KID PIX Preferences dialog, you can specify different KID PIX settings for each KID PIX 
user.

To set up KID PIX Preferences:

1 .  Choose KID PIX Preferences from the KID PIX application menu. The KID PIX 
Preferences dialog appears.

2 .  In the General pane, you can specify the following settings:
• If the Multiple user login checkbox is selected, the Login dialog will appear when you 

launch the application, and KID PIX documents will be saved separately for each KID PIX 
user. Changes to this option will be applied after you restart KID PIX.

• Click the Tool sounds checkbox to turn on or off the sound effects you hear when you are 
using the tools and trays in KID PIX.

• Click the checkbox labeled Project music and sounds to turn on or off sounds you have 
added to your projects.

• Select the checkbox labeled Read aloud project text to hear the text from text boxes 
read aloud.
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• Select the checkbox labeled Start application in full-screen view to have KID PIX fill 
the entire screen each time you open it. See “Using Full-Screen View” on page 75.

• Use the Default Font and Size pop-up menus to set the default format of text in the text 
boxes you create.

• Click the Choose button to select a location for automatic saving of your projects, Slide 
Shows, recordings, stickers, and other objects.

3 .  Click the Sharing icon at the top of the dialog to open the Sharing pane. Here you can sign 
in to YouTube so that you won’t be asked to log in each time you want to share a project or 
Slide Show.

4 .  Click the Slide Show icon to open the Slide Show pane and select settings for playing your 
Slide Shows:

• Select the Play sounds during Slide Show checkbox to hear all the sounds you have 
added to your projects and to the Slide Show itself when you play it.

• Select the checkbox labeled Read aloud text during Slide Show to hear text from text 
boxes in your projects read aloud when you play your Slide Show.

• In the Default New Slide Show Settings section you can specify settings that will be 
applied to all new Slide Shows by default:

• From the Transition Style pop-up menu, choose the style that will be used when 
advancing from one slide to the next in new Slide Shows. See “Setting Up Transition 
Options” on page 64.

• If you choose Custom from the Transition Style pop-up menu, the following three 
options become available:

• Transition Effect — Choose the transition effect to be used between slides.

• Transition Sound — Choose the transition sound to be played between slides.

• Slide Duration [X] seconds— Enter the interval after which Slide Shows will 
advance to the next slide.

• Choose a color to be used as the background of new Slide Shows from the Background 
Color pop-up menu
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5 .  Click the Help icon to open the Help pane and specify the following.
• If you want to see and hear helpful coaching hints on using tools and libraries, select the 

Get coaching hints after [1] second checkbox. In the number box, enter the time after 
which a hint related to the currently selected item will be given if there is no mouse or 
keyboard activity.

• If you want to see short explanations of what all the different tools and buttons do, select 
the Turn automatic help tags on checkbox. If you also want to hear the help tags, 
select the Speak automatic help tag text after [5] seconds checkbox and, in the 
number box, enter the time after which the text will be read aloud.

• Select the Read aloud alert messages option if you want to have the text of any alert 
messages that appear spoken out loud.

• From the Voice pop-up menu, choose the voice you want to be used for reading out 
coaching hints, help tags, and alert messages.

6 .  Click the Updates icon to open the Updates pane and select one of the following options.
• Select the Automatically check for updates checkbox to check for updates 

automatically each time you launch KID PIX when connected to Internet. If this checkbox 
is not selected, KID PIX will check for updates only when you click the Check Now button.

Activating Small Kids Mode
KID PIX has two modes: Normal Mode and Small Kids Mode. In Normal Mode, all the KID 
PIX tools and features are active. In Small Kids Mode, complex features (like most of the menu 
options, Slide Show, and printing) are inactive and KID PIX is always in full-screen view. This lets 
younger children create freely, without confusion.

In Small Kids Mode, children can:

• Use the all art tools.

• Add text to a picture using rubber stamp letters, symbols, and numbers instead of the 
keyboard. When a child clicks a character in the tray, KID PIX says its name out loud.

To turn Small Kids Mode on and off:

1 .  From the KID PIX application menu, choose Turn Small Kids Mode On. When you turn 
Small Kids Mode on, KID PIX automatically switches to full-screen view.

2 .  To return to Normal Mode, choose Turn Small Kids Mode Off from the KID PIX 
application menu.

Using Full-Screen View
Full-screen view lets you hide everything on the screen except for KID PIX, allowing users to focus 
their attention.

To turn full-screen view on and off:

1 .  From the View menu, choose Enter Full Screen, or press Control + Command + F.
2 .  To return to the standard window view, choose Exit Full Screen from the View menu, or 

press Control + Command + F again.
You can have KID PIX displayed in full-screen view automatically whenever you open the application. 
To do so, select the corresponding option in KID PIX preferences. See “Setting Up KID PIX 
Preferences” on page 73. KID PIX automatically switches to full-screen view when you turn on 
Small Kids Mode.
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Controlling Sound
Using the KID PIX Preferences dialog, you can turn on or off tool sounds, attached sounds, and 
Text-to-Speech effects. For more information on controlling sound settings, see “Setting Up KID PIX 
Preferences” on page 73.

Preventing Accidental Internet Access
KID PIX comes with some great sharing features and possibilities to connect to the Internet which 
are designed to make the software even more enjoyable and convenient for you and your children 
to use. At the same time, we take your privacy and security very seriously indeed. That’s why we 
have added the Parental Gate feature to KID PIX 5. It is intended to prevent younger users from 
inadvertently accessing the Internet or publishing their projects without your supervision. It works 
very simply: in most cases when a user tries to do anything in KID PIX that will result in an action 
like opening a web browser, logging in to YouTube, sending or sharing their work, or switching to a 
different application, a Parental Gate window appears with a task. The only way to proceed with 
the action is to complete the task.

A few of the commands in macOS system shortcut menus that are available in KID PIX, such as 
New Email With Selection and items in the Share submenu, cannot be controlled with Parental 
Gate. For added peace of mind you can disable these commands using the Keyboard > Shortcuts 
> Services; Extensions > Share Menu; and Parental Controls panes of your Mac’s System 
Preferences. For more information on using System Preferences, refer to Mac Help and other Apple 
documentation.
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Administrating the Login Dialog
Using the Login dialog, you can create multiple users or log in as a different user.

Add User

Delete User

Close the Dialog

User Name

List of Users

Add Users from List

Setting Up Multiple Users
For classroom use, or if lots of kids use the same computer, you can set up the application for 
multiple users. You can add users one by one or import a list of users.

To add multiple users one by one:

1 .  In the Login dialog, type kidpixadmin and then click Go. For details on opening the Login 
dialog, see “Logging In as a New KID PIX User” on page 78.

2 .  Type the names of new users and click the Add User button after each one to add them to 
the list.

3 .  Click Done when you have finished.

To import a list of users:

To add a number of users quickly, you can import a text file with a list of their names. The text file 
should contain one user name per line. (For example, type a user’s name, then press Return and 
move onto the next user.) Make sure the user names do not contain any restricted characters (:, /, \), 
do not start with a period (.) or a comma (,), and are not longer than 100 characters each.

1 .  In the Login dialog, type kidpixadmin and then click Go.

2 .  Click the Add Users from List button.

3 .  In the dialog that appears, navigate to the file with user’s names that you’ve created, select 
it, and click Open. The users’ names are added to the User List.

4 .  Click Done when you have finished.
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To delete a user:

1 .  In the Login dialog, type kidpixadmin and then click Go.
2 .  Select the user name you want to remove.
3 .  Click the Delete button.
4 .  Click Done when you have finished.

Logging In as a New KID PIX User
If you have more than one KID PIX user added, you can log in as any one of them any time you 
want while working with KID PIX.

To log in as a new user:

1 .  Click the Change User button at the top center of the KID PIX screen or choose Log In as 
New KID PIX User from the KID PIX application menu.

2 .  Select a user name in the User List.
3 .  Click Go.

Turning the Login Dialog On and Off
You can turn the Login dialog that appears when you launch KID PIX on and off. 

Once the dialog is turned off, all the KID PIX files you create will be saved by default to the home 
folder where your documents are stored.

To turn the Login dialog on or off:

1 .  Choose KID PIX Preferences from the KID PIX menu. The Preferences dialog appears.
2 .  In the General pane, select the Multiple user login option to turn the Login dialog on, or 

deselect the option to turn it off.
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The KID PIX Menus
In this chapter you will learn about:

• The KID PIX Application Menu
• The File Menu
• The Edit Menu
• The View Menu
• The Format Menu
• The Import Menu
• The Go Menu
• The Paint Zone Menu
• The Slide Show Menu
• The Help Menu

The KID PIX Application Menu
About KID PIX 
Tells you about the current version of the application, its developer team, and credits.

KID PIX Registration
Opens the KID PIX Registration page in your default web browser.

Provide KID PIX Feedback
Allows you to share your thoughts about KID PIX with us. Choose this command to open the KID PIX 
Feedback page in your default web browser.

KID PIX Preferences
Allows you to specify different settings of KID PIX for each user. For details, see “Setting Up KID PIX 
Preferences” on page 73.

Turn Small Kids Mode On or Off
Switches between the modes. For details, see “Activating Small Kids Mode” on page 75.

Log In as New KID PIX User
When you log in as a different user, Kid Pix uses the settings and folder locations specific to that 
user. For details, see “Logging In as a New KID PIX User” on page 78.

Services
Provides a quick way to perform tasks with several other applications.

Hide KID PIX
Hides all the windows of KID PIX.

Hide Others
Hides all applications except KID PIX. This clears the screen of everything but the KID PIX windows.

Show All
Shows all hidden applications.
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Quit KID PIX
Quits KID PIX. You can also click the Quit button in the Paint Zone or Slide Show area to quit the 
application.

The File Menu
New
Creates a new KID PIX project or Slide Show. For details, see “Starting Your New Project” on page 
57 and “Creating and Opening Slide Shows” on page 62.

Open
Lets you open an existing KID PIX project or Slide Show. For details, see “Opening Your Project” on 
page 58 and “Creating and Opening Slide Shows” on page 62.

Open Recent
Lists up to ten of the most recently used KID PIX projects or Slide Shows for you to open them 
easily.

Templates
Lets you create a coloring book project using the Idea Machine or create a project based on one 
of the Teacher Templates. For details, see “Saving Your Project as a Template” on page 58 and 
“Starting Your New Project” on page 57.

Save
Saves an open project or Slide Show. For details, see “Saving Your Project” on page 57 and 
“Saving Your Slide Show” on page 63.

Save As
Lets you save an open project or Slide Show to a selected location with a different name. For details, 
see “Saving Your Project” on page 57 and “Saving Your Slide Show” on page 63.

Save as Template
Lets you save an open project as a template and add it to the Teacher Templates pane in the Idea 
Machine. For details, see “Saving Your Project as a Template” on page 58.

Export
Exports your project or Slide Show in a different format. For details, see “Exporting Your Project” 
on page 60 and “Exporting Your Slide Show” on page 69.

Share to YouTube
Publishes your exported project or Slide Show to your YouTube account. For details, see “Publishing 
to YouTube” on page 71.

Send by Email
Opens the default email application and creates an email message with your KID PIX artwork  
attached. You can send a single project or a complete Slide Show.

Print
Prints an open project or Slide Show. For details, see “Printing Your Project” on page 59 and 
“Printing Your Slide Show” on page 69.
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The Edit Menu
Undo
Undo reverses the changes you made. For details, see “Using Multi-Level Undo Guy” on page 23.

Redo
Redo reverses the Undos. For details, see “Using Multi-Level Undo Guy” on page 23.

Cut
Removes the currently selected object and places it on the Clipboard.

Copy
Puts a copy of the currently selected object on the Clipboard.

Paste
Pastes the object from the Clipboard.

Select All Text
Selects all the text inside the active text box. (Applies only to text boxes.)

Show Spelling and Grammar
Opens the Spelling and Grammar window, which lets you check spelling and grammar in text 
boxes word by word and correct the mistakes. (Applies only to text boxes.)

Check Spelling
Checks the spelling in all the text boxes in your picture. (Applies only to text boxes.) For details, see 
“Checking Spelling” on page 28.

Check Spelling As You Type
Provides a dynamic spelling check while you are typing. (Applies only to text boxes.) For more 
details, see “Checking Spelling While Typing” on page 28.

Enlarge to Fill Canvas
Enlarges the currently selected object to fill the whole drawing area.

The View Menu
Enter or Exit Full Screen
Switches between full-screen view and standard window view. For details, see “Using Full-Screen 
View” on page 75.

The Format Menu
Font
Choose a command from the submenu to make selected text bold, italic, or underlined or change the 
font size.

Text
Choose a command from the submenu to change the alignment of selected text or to copy the style 
of selected text and then apply that style to another portion of text.
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The Import Menu
Photo
Opens the Import Photo window, which lets you import images from your Photos or iPhoto library. 
For details, see “Integration with iApps” on page 55.

Song
Opens the Import Sound window, which lets you import music from your iTunes library. For details, 
see “Integration with iApps” on page 55.

Video
Opens the Import Video window, which lets you import videos from your movie libraries. For 
details, “Importing videos into your project” on page 49.

Image File
Lets you add a graphic that’s stored on your hard disk or network to your KID PIX project as a 
sticker or as a background. For details, see “Adding Pictures” on page 50.

Sound File
Lets you add a sound that’s stored on your hard disk or network to your KID PIX project. For details, 
see “Adding Sounds” on page 51.

Movie File
Lets you add a video that’s stored on your hard disk or network to your KID PIX project. For details, 
see “Adding Videos” on page 53.

Video Narration
Opens the KID PIX Video Booth so you can record a video. For details, see “Video narration” on page 47.

The Go Menu
Go to Slide Show/Paint Zone
Switches you from Paint Zone to Slide Show and back.

The Paint Zone Menu
Alphabet Text
Lets you enter text to paint with using the Letters Wacky Paint option. For details, see “Alphabet Text 
Tool” on page 25.

Say It This Way
Lets you teach KID PIX how to pronounce words it doesn’t know, like names and places. For details, 
see “Teaching KID PIX to Pronounce” on page 30.

Flatten Selected Object
Makes the selected object a part of the background.

Flatten All

Makes all text objects, stickers and animations, or movies a part of the background.
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Bring to Front
Places the selected object in front of all other objects.

Bring Forward
Brings the selected object one layer forward.

Send Backward
Sends the selected object one layer backward.

Send to Back
Places the selected object behind all other objects.

Flip Horizontally
Flips the selected object from left to right.

Flip Vertically
Flips the selected object upside down.

Select Previous Object
Selects the previous object on the canvas.

Select Next Object
Selects the next object on the canvas. 

Make Sticker
Creates a sticker from a selected frame of a movie or animation, a text object, or an area of the 
background you have cut out with the Scissors tool. For details, see “Creating Your Own Stickers” 
on page 37.

Make Video Background
Turns the selected video into the background of your project by sending it to the back layer and 
enlarging it to fill the canvas.

Add to Slide Show Tube
Creates a new Slide Show with the current project as the first slide or, if a Slide Show is already 
open, adds the current project as the last slide. For details see “Adding Projects to Slide Shows” on 
page 62.

The Slide Show Menu
Transition Style
Opens the Slide Show Style dialog, where you can set up or change transitions for your current 
Slide Show. See “Setting Up Transition Options” on page 64.

Change Background Color
Opens the Background Color dialog, where you can change the background color for your current 
Slide Show. See “Changing Background Color” on page 68.
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Change Background Sound
Opens the Background Sound dialog, where you can change the background sound for your 
current Slide Show. See “Changing Background Color” on page 68.

Record Voiceover
Lets you record a full-length voiceover for your Slide Show. See “Adding a Voiceover to Your Slide 
Show” on page 67. 

New Slide
Adds a new slide to the end of your current Slide Show and lets you choose a project to appear in it.

Load Picture
Lets you choose a project to appear in the currently selected slide.

Loop (Play Continuously)
Allows you to play your Slide Show in a loop, starting again from the first slide after playing the last 
one. For details, see “Customizing Your Slide Show” on page 64.

Turn Manual Advance On or Off
Changes the transition settings of your Slide Show so that you need to click or press a key on your  
keyboard to advance to the next slide. For details, see “Using Manual Advance” on page 64.

The Help Menu
KID PIX User Guide
Opens this User Guide in your default PDF viewer. For details, see “Getting Help” on page 12.

KID PIX Tutorials
Sends you to the online KID PIX tutorials.

Turn Help Mode On or Off
Enters or leaves Help Mode, in which you can learn about KID PIX tools and how to use them. For 
details, see “Getting Help” on page 12.

Turn Help Tags On or Off
Allows help tags to appear, or stops them from appearing, when the pointer is held over a tool or 
button for a few seconds. For details, see “Getting Help” on page 12.

KID PIX Tech Support
Connects your web browser to the KID PIX Technical Support web page. For details, see “Getting 
Technical Support” on page 89.
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Command-, Opens the KID PIX Preferences dialog. For more information, see “Setting Up 
KID PIX Preferences” on page 73.

Command-Q Quits KID PIX.

Command-N Creates a new KID PIX project or Slide Show. For details, see “Starting Your 
New Project” on page 57 and “Creating and Opening Slide Shows” on page 
62.

Command-Shift-N Opens Add a New Slide dialog. 

Command-O Opens a KID PIX project or Slide Show. For details, see “Opening Your Project” 
on page 58 and ““Creating and Opening Slide Shows” on page 62.

Command-Shift-O Opens Load a Picture dialog.

Command-S Saves an open project or Slide Show. For details, see “Saving Your Project” on 
page 57 and “Saving Your Slide Show” on page 63.

Command-Shift-S Opens the Save As dialog or Save Slide Show As dialog for you to save an 
open KID PIX project or Slide Show to a selected location with the name you 
specify.

Command-Control-S Opens the Save As Template dialog for you to save an open KID PIX project 
as a template and add it to Teacher Templates. For more information, see 
“Saving Your Project as a Template” on page 58.

Command-P Opens the Print dialog for you to print the current project or Slide Show. 
For details, see “Printing Your Project” on page 59 and “Printing Your Slide 
Show” on page 69.

Command-Z Undoes the last actions one by one. For details, see “Using Multi-Level Undo 
Guy” on page 23.

Command-Shift-Z Redoes what has been undone. For details, see “Using Multi-Level Undo Guy” 
on page 23.

Command-X Cuts the currently selected object and places it on the Clipboard. 

Command-C Puts a copy of the currently selected object on the Clipboard. 

Command-V Pastes the object from the Clipboard. 

Command-A Selects all the text inside a selected text box. For more information, see “Select 
All Text” on page 81.

Command-; Checks the spelling in all the text boxes in your picture. (Applies only to text 
boxes.) For details, see “Checking Spelling” on page 28.

Command-L Enlarges the currently selected object to fill the whole drawing area. 

Command-Control-F Turns full-screen view on and off. For details, see “Using Full-Screen View” on 
page 75.

Command-B Makes text bold style.

Command-I 
(letter “I”)

Makes text italic style.

Command-U Makes text underlined.

Keyboard Shortcuts
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Command-+ Makes the font size bigger.

Command-— Makes the font size smaller.

Command-{ 
(left brace)

Aligns the selected text to the left side.

Command-| 
(pipe character)

Aligns the selected text by the center axis of the text object.

Command-} 
(right brace)

Aligns the selected text to the right side.

Command-Option-C Copies the style of selected text.

Command-Option-V Applies previously copied style to selected text.

Command-Shift-F Places the selected object in front of all other objects.

Command-Option-
Shift-F

Places the selected object behind all other objects.

Command-Option-
Shift-B

Brings the selected object one layer forward.

Command-Shift-B Sends the selected object one layer backward.

Command-[ 
(left bracket)

Selects the previous object on the canvas.

Command-] 
(right bracket)

Selects the next object on the canvas.

Command-Shift-M Makes sticker from selection.

Command-Shift-A Creates a new Slide Show with the current project as the first slide or, if a Slide 
Show is already open, adds the current project as the last slide. For details, see 
“Adding Projects to Slide Shows” on page 62.
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Frequently Asked Questions 
The questions and answers in this chapter include: 

• Why do some things become a part of the background, while others remain separate? 

• Can I save a KID PIX project or Slide Show in another format, so other people can see it?

• Can I open KID PIX 3D files in KID PIX 5?

• How do I use the Sound Art tool? 

• What is the difference between Rubber Stamps and Stickers? 

• What is the difference between animations and animated Wacky Paint or Moving Paints 
mode options? 

• How limited is the path animation area?

• What should I do if I have made an Slide Show but I want to edit a project in it?

• How can I correct mistakes I have made?

Q: Why do some things become a part of the background, while others remain separate? 

A: In KID PIX, a picture is like a piece of paper with a layer of clear plastic over it. Things you add 
to the background cover each other, just as if you had painted them on a piece of paper. Objects 
like stickers, animations, sounds, movies, and text boxes float over the background, on the 
plastic layer. They remain independent until you flatten them. Flattening an object merges it into 
the background. 

You can pick up items on the plastic layer and move them, resize them, and (for animations, 
sounds, or movies) play them. 

Some actions cause things to flatten even if you do not flatten them yourself. For example, when 
you export a picture, the objects get flattened as a result, because the export format does not 
know how to display them otherwise. 

Q: Can I save a KID PIX project or Slide Show in another format, so other people can see it? 

A: Yes. To open a project or Slide Show on another computer without KID PIX 5 on it, export your 
work as an image or image sequence, a movie, or an HTML5 page. Most computers can open 
such files. For more information, see “Exporting Your Project” on page 60 and “Exporting Your 
Slide Show” on page 69. You can also share your movies by uploading them to  
www.YouTube.com. See “Publishing to YouTube” on page 71. To open a project or Slide Show 
on another computer that has KID PIX 5, just transfer the project file or Slide Show file to the 
other computer (as an email attachment, for example, or using a USB flash drive).

Q: Can I open KID PIX 3D files in KID PIX 5?

A: Yes. While it’s not possible to open files from KID PIX 5 in KID PIX 3D, you can open your KID 
PIX 3D files in KID PIX 5. However, some objects and features will not be included in the opened 
file. These are: certain 3D animations, multiple text styles within one text box, Slide Show 
transition options, “Say It This Way” pronunciations, and media in unsupported formats.

Q: How do I use the Sound Art tool? 

A: The Sound Art tool paints abstract images that get their size and shape from the pitch and 
volume of sounds you put in through your computer’s sound input device. Talk or sing into your 
computer’s microphone, and the Sound Art tool will “paint” those sounds. 
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To select the Sound Art tool, click the Painting Tools button and click the Sound Art tool in the 
tray. Then select the “Hands-free” or “Mouse-move” mode in the tool options tray. 

If you select the “Hands-free” mode, you can make noise into the microphone and KID PIX will 
paint for you. If you select “Mouse-move”, you can direct the painting with the mouse and make 
noise at the same time to form the painting. For details, see “Using Painting Tools” on page 15. 

Q: What is the difference between Rubber Stamps and Stickers? 

A: Rubber Stamps are pictures you “stamp” into your picture. They immediately get flattened 
into the background. You can edit rubber stamps using the Stamp Editor. You can’t edit rubber 
stamps once you have added them to your picture. For details, see “Using Rubber Stamp Tools” 
on page 20.

Stickers are pictures you add to your KID PIX picture that remain independent objects. You can 
move and resize them unless you flatten them. For details, see “Stickers Library” on page 36. 

Q: What is the difference between animations and animated Wacky Paint or Moving Paints 
mode options? 

A: Animations are stickers that move, like very small movies. Animations are played when you 
play your picture. Animations remain independent objects after you add them to your picture. 
You can move and resize them unless you flatten them. For details, see “Animations Library” on 
page 38.

The Wacky Paint mode options of Paint Brush and the Moving Paints mode options of Spray 
Can are Painting Tools that paint with magical effects. After you paint with them, they animate 
for a short period, then get flattened into the background. You can’t move or change what you 
create with these tools the way you can with an animation. However, when you start playing your 
project, the Moving Paints are initially invisible. They then appear on the canvas in the same 
order as you painted them. For more information, see “Using Painting Tools” on page 15.

Q: How limited is the path animation area?

A: It isn’t limited at all. Animation paths can even be drawn outside the canvas, although you 
won’t see the object when it is away from the drawing area. For more information on creating 
animation paths, see “Path Animation Tool” on page 40.

Q: What should I do if I have made an Slide Show but I need to edit a project in it?

A: You just have to click the project you want to edit in the Slide Show Tube. The project 
will open on the canvas, where you can make all the changes you need. Your changes will 
automatically be saved.

Q: How can I correct mistakes I have made?

A: Undo Guy will take you back as many steps as you need. For details, see “Using Multi-Level 
Undo Guy” on page 23.



89

USER GUIDE
®

Getting Technical Support

Getting Technical Support
If you experience any problems using KID PIX 5, choose KID PIX Tech Support from the Help 
menu. Your web browser will take you to the KID PIX 5 Technical Support page. 

If you cannot launch KID PIX 5, or if you want to leave feedback, please go to the Software MacKiev 
web site (www.mackiev.com), follow the link to Support, click the KID PIX icon, and then choose 
Mac Edition. On the page that opens, scroll to the bottom and click the link to “Technical Support 
Request”.

http://www.mackiev.com/
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A
Add a Background  34
Adding Text  24
Alphabet Text command  25, 82
Animations

adding  38
copying  31
creating from Slide Show  70
deleting  39
editing frame  39
flipping  39
library  38
library button  38
moving  31, 39
pause playing  40
playing frame-by-frame  40
playing in a loop  40
resizing  39
rotating  39
tray  38

Art Tools  14
Auto-perspective effect  41

B
Backgrounds

adding  34
combining  35
importing  35
library  34
removing from picture  34
tray  34
video backgrounds  35

Big Eraser  22
Blend of Colors Paint Bucket  18
Bold font style  28
Button stickers  38

C
Card / booklet  69
Center at original size

for backgrounds  36, 50, 56
Chalk  14
Check Spelling  28, 81
Check Spelling As You Type  28, 81
Circle Cutout  32
Coaching Help  13
Colors

choosing  21
Color Swatch  21
Comic book  69
Cookie Cutter  32
Copy command  81
Copying

objects with Grab tool  31
text  25

Crayon  14
Curved line drawing  15
Cut command  81
Cutting

circles or ellipses  32
parts of a picture  32
squares or rectangles  32
text  25

D
Deleting

animations  39
slides from Slide Show  63
sounds  44, 46
stickers  37
text boxes  27

Dragging projects in Slide Show  63
Drawing

curved lines  15
paper texture  15
rubber stamps  20

Drawing Tools
button  14
paper texture  15, 17
shapes  14

E
Edit frame

for animations  39
for stickers  36
for text  26

Edit menu  81
Enlarge to fill canvas  81, 85
Erasers

effect options  22
shapes  23
sizes  22

Eraser Tools button  22
Erasing

entire picture  22
parts of a picture  22

Exporting
project  60
Slide Show  69

Eye Dropper  22

F
File menu  80
Fill canvas without shrinking/stretching

for backgrounds  36, 50, 56
Fit to page  59
Flattening

animations  82
movies  82

Flipbook transition  65
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Flipping
animations  39
rubber stamps  20

Font
changing  28

Format menu  81
Formatting text  28
Free Cutout  32
Frequently Asked Questions  87
Full page

printing picture as  59
printing Slide Show as  69

G
Go menu  82
Grab tray  31

H
Help

coaching  13
getting  12
menu  84

Hide KID PIX  79
Hide Others  79
HTML5  70
HTML5 Page  60

I
Idea Machine  57
Import

background  35
from iTunes  56
from Photos  35, 55, 82
graphic  50, 82
menu  82
sound  45, 51, 82
video  82

Installing
KID PIX  9

Interactive objects  43
Italic font style  28

J
JPEG pictures

importing as background  36

K
Keyboard shortcuts  85
KID PIX

about  79
customizing  73
getting started  9
getting technical support  84, 89
installing  9
launching  9
libraries  33
menus  79

preferences  73
registering  79
removing  13
user guide  13, 84

L
Launching KID PIX  9
Letters Wacky Paint option  26
Libraries  33
Library

buttons  33
trays  33

List of Voices pop-up menu  29
logging in to KID PIX  10
Log In as New KID PIX User  79
Login dialog

administering  77
Loop

playing animation in a loop  41

M
Make Sticker (button)  32, 38
Make Sticker (command)  83
Marker  14
Mega Mixer  19
Menus

in KID PIX  79
using  12

Mini Eraser  22
Mixers

effects  19
sizes  19
tray  19

Mixer Wand  19
Moving

animations  39
objects with Grab tool  31
pictures in Slide Show  63
stickers  37
text boxes  27
videos  31

Multiple soundtrack  45

N
Narration

Slide Show  67
sound  45
video  47

New
command  80
Create New Project button  57

Normal Mode  75

O
Object

attaching sounds  52
interactive  43
resizing  31
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Opening
projects  58
Slide Shows  62

P
Page advance options  65

customizing Slide Show  64
when text reading finishes  66

Paint Buckets
Blend of Colors  18
button  18
Multicolor Pattern  18
Single Color  18
tray  18

Painting Tools
button  15
modes  15
sizes  15
texture  17
tray  15

Paint Zone  11
menu  82

Parental Gate  76
Paste button in tray  25
Paste command  81
Pasting

text  25
with Grab tool  31

Path animation  40
Pencil

for rubber stamps  20
tool  14

Photographs
adding  50
importing  55

Photos app  55
Pictures

adding  50
Play

picture  58
Slide Show  64

Preferences  73
Print

button  59, 69
command  80
picture  58
shortcut  85
Slide Show  69

Projects
deleting from Slide Show  63
exporting  60
moving in Slide Show  63
new  57

Publish
to YouTube  71

Q
Quit  80, 85

R
Redo command  81, 85
Registration  79
Removing KID PIX  13
Resizing

animations  39
pasted object  31
text boxes  27

Reversing actions  23, 81, 85
Rotating rubber stamps  21
Rubber Stamp Editor  20
Rubber stamps

adding  20
and stickers  88
changing  20
Restore Original button  21

Rubber Stamp Tools button  20

S
Save As command  58, 80
Saving

projects  57
Slide Shows  63

Select All Text  81, 85
Send by Email  80
Sending artwork  80
Services  79
Setting up

multiple users  77
preferences  73

Share menu
YouTube  80

Show All  79
Shrink/stretch to fill canvas

for backgrounds  36, 50, 56
Slide Show  12

background color  68
creating animations from  70
exporting  64
menu  83
opening  62
play continuously  64
printing  69
saving  63
transition options  64
voiceover  67

Small Kids Mode
activating  75
printing in  59
text in  25
turning on or off  79

Sound Art tool
frequently asked questions  87
Mouse-Move mode  16
painting tools  16

Sound formats  51
Sound Recording tray  45
Sounds

for individual objects  52
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importing  45, 51
library button  44
recording  45
removing from My Sounds  46
removing from picture  44

sound volume  44
setting for videos  47

Spelling
checking  28, 81
checking as you type  28, 81

Spray Can
Moving Paints mode  17
Paint Shapes mode  16

Square Cutout  32
Stamp Editor  20
Starting

new pictures  57
with the Idea Machine  57

Stickers
adding  36
button stickers  38
copying  31
deleting  37
library button  36
moving  37
rubber stamps  88
tray  36

Storybook printing  69
System requirements  6

T
Technical Support  89
Template projects  58
Text

aligning  28
centering  28
changing size  28
changing style  28
check spelling  28, 81
check spelling as you type  28, 81
copying  25
cutting  25
options in preferences  73
pasting  25
playing  29
reading out loud  28
selecting all  81, 85
setting font  28
slide advance option  66
tray  24

Text boxes
deleting  27
flattening  27
formatting text  28
moving  27
moving off page  27
resizing  27

Text style  28
Text Tools button  24, 28

Text-to-Speech
changing voice for  29

Thumbnail printing  69
Tile

for backgrounds  36, 50, 56
Transition Effect

changing  65
Turn Manual Advance On or Off  64, 84
Turn Small Kids Mode On or Off  59, 75, 79

U
Underline font style  28
Undo

Undo Guy  23, 81, 85
User Guide  13, 84

V
Video Narration  47, 82
Videos

adding  46, 53
library  46
moving  31
playing  54
playing frame-by-frame  54
playing in a loop  54
video backgrounds  35

View menu  81

W
Wacky Paint mode

difference from animations  88
painting  16
text  26

What’s New in KID PIX 5  7
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